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Origin:  The “Kids Capture Their Universe” (KCU) out-of-school time program was 
developed by the education and outreach group at the MIT Kavli Institute for Astrophysics 
and Space Research (MKI) and the Science Education Department at the Smithsonian 
Astrophysical Observatory (SAO) during 2006 and 2007, in partnership with Citizen 
Schools, Boston.  Final pilot testing was completed in Boston during spring 2008.  By May 
2009, the KCU program had been run 13 times in 9 locations, engaging about 80 youth, 
with youth presenting to hundreds of community members, parents and other students.  
The initial funding for KCU was provided through the Education and Public Outreach 
program of NASA’s Chandra X-Ray Observatory.   
 
Activities:  KCU grew out of a desire to share authentic aspects of being an astronomer 
and astronomy educator with young people.  Following the Citizen Schools approach 
(http://www.citizenschools.org/whatwedo/ourmodel/apprenticeships.cfm), KCU is designed 
as an apprenticeship where adults share their expertise and passion by helping youth to 
create a product, performance, or presentation produced by the students and taught back 
to the community.  In KCU, the product is a live astrophotography exhibit.   
 
The KCU apprenticeship is designed for 90-minute sessions once per week for 11 weeks, 
where hands-on learning projects emphasize the broad set of skills necessary for success 
in the modern economy: leadership, teamwork, oral communication and technology.  In 
KCU, youth learn to request astronomical images from the MicroObservatory robotic 
telescope network and use image-processing software to reveal and emphasize important 
details about their images, just as professional astronomers do.  They work in small groups 
to organize and present an astrophotography exhibit made of several “stations,” each 
complete with images, written captions, 3D models, and creative poems reflecting the 
science content they learn.  In addition, youth teach the audience to use software to 
explore and personalize their own images of the universe.    
 
Outcomes:  The KCU activities give youth an opportunity to develop the following focused 
skills, identified by Citizen Schools as “New Basic Skills”:   
Teamwork:  Youth are able to contribute to group work while sharing the “spotlight.”  
Leadership:  Youth are able to speak more confidently in front of an audience. 
Advanced Literacy:  Youth are able to correctly apply terms and vocabulary associated 
with the KCU program. 
 

Implementation:  The apprenticeship approach followed in KCU can be implemented by a 
variety of out-of-school-time (OST) organizations to support their missions to promote 
science and technology learning.  It is also an effective way to engage space science 
professionals, amateurs and graduate/undergraduate students (called “astronomy 
volunteers”) in a satisfying and productive outreach experience.   



Kids Capture Their Universe: An Astronomy Out-of-School Program 
 

The “Kids Capture Their Universe” (KCU) astronomy program was developed  
by MIT Kavli Institute (MKI) and the Smithsonian Astrophysical Observatory (SAO),  
in partnership with Citizen Schools, Boston.  

 

2 

Table of Contents 
 
 Introductory Materials (review these before beginning the program) 
 

Overview of the Program ……………………………….…………..…. Page 3 
Products Needed for the astrophotography exhibit ….......…………. Page 4 
Supply List for the Program ……………..……………………………. Page 4 
Technical Requirements ………………………………………………. Page 5 
Computer File Management Guide …………………………………... Page 6 
Facilitating New Basic Skills …………………………………………... Page 8 
Creating An Image Wall ………………………………………………... Page 9 
 

 Weekly Lesson Plans (use these to plan your weekly sessions) 
 

Program Fair/Image Wall …...………………………………………… Page 12 
Week 1 (With a Telescope) ..……...…………………………………… Page 13 
Week 1 (Without a Telescope) ….…………………………………….. Page 21 
Week 2 (Moon and Planets) …….…………………………………….. Page 29 
Week 3 (Stars and Nebulae) ..………………………………………… Page 35 
Week 4 (Galaxies) ...…………………………………………………… Page 43 
Week 5 (Field Trip) ………………...…………………………………… Page 49 
Week 6 (Final Images) ………………………………………………… Page 51 
Week 7 (Creative Element Construction) ………...…………………. Page 55 
Week 8 (Exhibit Construction) …....…………………………………… Page 59 
Week 9 (Presentations) ………………………………………………... Page 69 
Week 10 (Astronomy Idol) …………………………………….............. Page 73 
Week 11 (Optional Reflection) ………………………………………… Page 75 
Supplemental Activities ………………………………………………... Page 70 
 
Worksheets and Templates (copy these for youth as necessary) 
 

Pre/Post Program Survey ……………………………………………… Page 80 
Observing & Processing Logs …...……………………………………. Page 82 
Checklist for astrophotography exhibit ….…………………………… Page 84 
Oral Presentation Planning …...……………………………………….. Page 86 
Presentation Feedback Form …...…………………………….............. Page 87 
Image Display Template …...………………………………….............. Page 88 
Group Preference Forms …...………………………………………….. Page 91 
 
Appendices (for facilitators’ reference) 
 

Token Astronomical Images and Descriptions ……………………… Page A-1 
Vocabulary Master List …...……………………………………………. Page B-1 
Processing Challenges Key …...………………………………………. Page C-1 
Kinesthetic Life Cycles of Stars Summary …...………………………. Page D-1 
Materials for Hands-on Telescope Activities ………………………… Page E-1 
Illustrated Processing Guide …...……………………………………… Page F-1 



Kids Capture Their Universe: An Astronomy Out-of-School Program 
 

The “Kids Capture Their Universe” (KCU) astronomy program was developed  
by MIT Kavli Institute (MKI) and the Smithsonian Astrophysical Observatory (SAO),  
in partnership with Citizen Schools, Boston.  

 

3 

Overview of the Program 
 
Program Advertisement: The Facilitators introduce potential youth to the program 
through interactive demonstrations of program experiences (image processing and/or 
astro-creative activities) and/or showcases of program topics (telescopes, 
astrophotography and/or exhibitions)  
 
Weeks 1-5: The first half of the program is spent learning the “tools of the trade” and 
developing teamwork and presentation skills. Each week consists of three key 
components, in addition to the opening and closing circles: 
 

• Icebreaker/Team-Building Activity 
 

Part of the opening circle, each week includes a non-astronomy activity that helps the 
group get to know each other better and foster a fun, supportive environment. 
 

• Image Requests and Processing 
 

In addition to learning how to use the MicroObservatory telescopes to request images of 
astronomical objects, youth gain familiarity with basic image processing techniques for 
astronomical images. Explorations consist of a guided activity (in which the facilitator 
models the use of one or more processing tools), a challenge (in which youth re-create a 
pre-processed image using those tools), and free processing (in which youth apply these 
tools to the images they have requested). Youth also create descriptive captions to 
accompany each processed image and practice sharing and reflecting on these images 
with their fellow youth and facilitators. 
 

• Astro-Creative 
 

Youth devote time each week to a hands-on project that draws upon and showcases their 
creative talents: kinesthetic modeling, poetry, and art/sculpture 
 

• Week 5 is traditionally devoted to a field trip, during which youth can talk to experts, 
share and ask questions about their images, see real telescopes, and/or visit a 
professional museum exhibition. 

 

The knowledge, skills, and products developed during Weeks 1-5 will be incorporated into 
the final exhibition and/or used as an example for creating the displays and presentations. 
 
Weeks 6-10: The second half of the program is spent assembling the final 
astrophotography exhibit displays and presentations, using the skills and products 
developed during the first half of the program. Youth practice presenting and 
demonstrating their projects and skills. 
 
Astrophotography exhibit: The final exhibition is presented to the community. Be sure to 
start planning this before the program begins so you can communicate clear expectations 
to the youth! 
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Products needed for the Astrophotography exhibit: 
 

Each group of youth should create: 
 

1. A portable exhibit display, mounted on poster board/foam core or other display 
structure that can be set up on a table or easel. Each display must contain: 

• Quality images of several objects, taken with MicroObservatory and 
processed by the youth using the MicroObservatoryImage software 

• Youth-written captions for each image in the display 

• Individual and/or group-made poem and/or 3D model that adds to the 
understanding of the theme of that part of the exhibition 

• Title and descriptive summary of the display 
 

2. A well-rehearsed oral presentation, featuring one or more elements of the exhibit 
display above and presenting information about astronomy and/or the program to 
visitors in a creative way. Presentation topics could include: 

• Explanation/guided tour of the exhibition 

• Explanation/demonstration of image processing, focusing on one or more 
specific tools and/or images presented in the display 

• What happened during the program 

• An explanation of how telescopes work and what they do, using images, 
sketches and/or a real telescope 

• Information about a class/category of objects, as demonstrated with their 
own images 

• A comparison of MicroObservatory images with professional astronomy 
images 

• Demonstration/explanation of a kinesthetic model 

• Interactive demonstration of physical model building or sculpture based on 
one or more images. 

• Interactive demonstration of poem making, based on one or more images. 
 

All displays should be arranged into a creative exhibition with approximately 15’ x 15’ floor 
space. Presentations may be given as part of the exhibition or in an auditorium. 
 
Physical supplies needed for the program (quantities reflect 8-12 youth) 
 

o 20 pens/pencils, 20 markers, 150 blank note cards, hanging file folders (one per youth), 
sticky notes, ~100 colored dot stickers, name tags, 5 glue sticks, masking tape, Scotch 
tape & dispenser, dry erase markers/eraser, 3-4 scissors, stapler, small box of clay, 4-5 
blindfolds, prizes (e.g. candy, trinkets), large chart paper (for wall) and craft supplies, 
as described in Week 4 (page 48) 
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Technical Requirements for Running the Program 
 
Ideal requirements:   
• Computer area/room with one (1) computer per youth (PC or Mac OK) 
• Every computer has internet connection with access to 

http://www.MicroObservatory.org  
• Every computer has free access to read and write to a USB memory key. 
• One USB memory key for each computer.  Materials on key include the following: 

o Free MicroObservatory Image processing software:  http://mo-
www.harvard.edu/MicroObservatoryImage/ (Can be run from the key.) 

o Folders for incoming requested images and youth processed images.   
 

• Access to color printer for final exhibit images 
• Access to black and white printer/copier  
 
• Access to computer specialist to help (on minimal “as needed” basis) with the following:  

o Initial software installation / setup  
o Change computer display properties  
o Clarify procedures for use of computers  
o Resolve technical problems 
 

• Activities area:  10-12 people able to stand in an open circle  
• Secure, accessible storage space for materials (approximately 2 hanging file folder 

boxes) 
 
Acceptable alternatives to ideal setup above: 
• One computer per pair of youth 
• Only 1 to 2 computers with Internet connection:  Youth will have to share when 

requesting images. 
• As an alternative to USB memory keys, each computer must have the following: 

o Free MicroObservatory image processing software (http://mo-
www.harvard.edu/MicroObservatoryImage/) downloaded, installed, and 
running. 

o Ability to save files to a location easily accessed by the facilitator and youth. 
o Stability of computer such that software installation / saved files, etc. are not 

erased or moved from week to week.  
o Ability to transfer files between computers (local network or flash drive or disk 

drive with read/write access, etc.), so facilitator can collect/distribute image 
files.  
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Computer File Management Guide 
After youth request images, the following 4 file management steps must be taken before 
the image is ready for the exhibit.    
 
1.  Retrieve FITS images from MicroObservatory 
 

BY EMAIL:  When an image is requested via the MicroObservatory Guest Observer Portal, 
the telescope will take the image that night and send an email to the user’s email address, 
assuming it was entered correctly. The easiest way to access the image is to check the 
email account and click on the link provided in the email. 

The email will come from MicroObservatorySupport@cfa.harvard.edu   Users may 
wish to set up a filter in the mail program so that all emails from this address go to the 
same folder. 

Due to security constraints on public computers, however, youth may not be able to check 
their email on the school computers. The best way to deal with this issue is for a facilitator 
to pre-load the youth’s USB memory keys or computers each week with the images 
requested the previous week. We recommend having all image requests by youth sent to 
an independent email address created and monitored by the facilitator, using a service like 
Google Mail.   
 
BY WEB:  If retrieving images via email is not possible, the images can be accessed via 
the web, at either of these two locations: 

 
• The daily index of the Guest Observer Portal images:  

http://mo-www.harvard.edu/GA/ImageAnalysis/TodaysImagesMM:DD:YYYY  
(fill in the month, day, and year for the day AFTER the images were requested)  

 
• Main MicroObservatory Image Directory: 

http://mo-www.harvard.edu/jsp/servlet/MO.ID.ImageDirectory  
(look for users “moguest” and “cquestions” on the correct date) 

 
Be sure to retrieve and transfer the unprocessed FITS files, not the GIF thumbnails! 
Note that links above include MORE images than those requested by the youth. If this is 
the intended method of retrieval, it may be useful for the facilitator to make note of the 
images requested by youth so that only those images get downloaded and transferred to 
the youth’s USB memory keys or computers. 

2.  Transfer FITS images to USB memory keys or computers 

Once the images requested by youth are gathered, they must be made available to youth 
for processing.  Do this before the session begins.  It is the facilitator’s responsibility to 
make sure youth have the images they need for each session.  Some options: 
 

1. Load all requested images onto USB memory keys for access by youth.  Easiest 
option is to put all new requested images onto every key, so youth can access all.    
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2. Upload all requested images to a central server and download them to each 

machine. (Make sure there is a valid Internet connection on each machine.) 
 

3. Some combination of the above (e.g. upload images to a server, download them to 
one computer and transfer them to others via flash drive.) 

 
Unprocessed FITS images should be stored on identical folders on each USB memory key 
or computer, so that all youth can follow a single procedure for retrieving them. We 
suggest weekly request folders within a larger “Images” folder. 

3.   Youth save processed GIF images 

Choose a system that works for you and be consistent. Once an image is processed by 
youth, they should save it into a location accessible to the facilitator.  Some options: 
 

1. A collective “Processed Images” folder (if youth do not use a consistent USB 
memory key or computer each week) 

 

2. A personal “Name’s Processed Images” folder (if youth use the same USB memory 
key or computer each week) 

 
Youth will need to specify the folder when they click “Save As…” because the default is 
the same folder from which the original FITS image was retrieved. 
 
If you are NOT using USB memory keys:  Before the program begins, make sure that 
images (and the image processing software) will remain on the computers from 
week to week. Double-check this during Weeks 1 & 2! If the machines are cleared each 
time the youth logs out, you will need to reinstall both the software and the images each 
week, including the original FITS files and the youth’s processed GIF images. 
 

4.  Facilitator retrieves youths’ processed GIF images for storage or printing 

Two options: 
1. Collect all USB memory keys or other portable media storage device 
 

2. Upload images to a central server to download and print later 
 
It is expected that facilitators will be responsible for printing the final color images for 
the youths’ exhibits.  
 

 
YOUR GOAL is to find a system that works well at your site. Astronomy volunteers should 
work with out-of-school time staff to make sure youth can find and save their images 
appropriately.  
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Facilitating New Basic Skills 
 
There are several ways in which to support the development of these skills, which are built 
into the KCU curriculum.  
 
Working with vocabulary:  Each week, there are 4-5 “focus vocabulary” words. These 
words and their definitions should be printed out, possibly laminated, and posted 
prominently in the room before the start of each session. (See Appendix B.)  Additional 
vocabulary that come up in each lesson can be presented, but maintain specific effort on 
using the focus vocabulary. Other ideas include the following:   

• Presenting vocabulary at start of lesson:  Several approaches include a physical 
scavenger hunt to locate the printed definitions scattered around the room, 
assigned youth read vocabulary out loud, or the facilitator  reads vocabulary out 
loud. The introduction of vocabulary should be very short, but then incorporated 
throughout the lesson. 

• Caption writing:  This is the most important way youth can learn vocabulary and 
content. Award points for correctly using vocabulary in written captions, with team or 
individual points across one day leading to recognition/ award.  

• Vocabulary “jeopardy”:  Although a version of this is included explicitly in week 8, at 
any time youth can be challenged to recall a vocabulary word based on its 
definition, or an image that shows or demonstrates it. (e.g. “What kind of object is in 
this image?”  A planet!  or “Which tool was used in processing this image?”  Zoom!) 

• At closing circle:  Based on their experience that session, have youth define or give 
an example of one of the vocabulary in their own words.  

  
Supporting teamwork:  In addition to the “Lighthouse game” in week 7 and the group 
selection of exhibit materials and exhibit groupings, other ideas include the following:   

• Image processing:  After week 1, youth can be paired during “free processing time” 
and develop processing challenges for their partner (i.e. can you make your image 
look like mine?) 

• Caption writing:  Paired youth can write captions for their partner’s image, forcing 
them to interview their partner for information.  

• Closing circle:  Youth can give recognition to good work done by peers, including 
recognizing good image / caption combinations on the image wall (see next section) 

• Image wall:  Based on initial caption/image combinations on the wall, youth can add 
more comments/ questions to each caption, leading to a richer discussion, and 
“group-created” captions.  

 
Speaking confidently in front of an audience:  In addition to the presentation demonstration 
and games in weeks 9 and 10, other ideas include the following: 

• Caption writing:  With any additional time, youth read captions aloud to partners or 
the group. 

• Introducing vocabulary:  Youth read vocabulary aloud to partners or the group. 
• Closing circle:  Read captions or give verbal recognition to the work of others.  
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Creating an Image Wall on Ongoing KCU Program astrophotography exhibit board 
 

During pilot runs of this program, pilot facilitators expressed a need for weekly physical 
recognition of the youth’s work: 
 

A physical or electronic display of youth’s color images, accompanied by 
information about them (process to create, contents, inspiration, etc.), 
contributed by the creator and/or peers 

 
There are many reasons for doing this: 
 

• Actually seeing printed/publicly displayed images provides concrete sense of 
accomplishment and progress toward the final exhibit 

• Encourages teamwork and cooperation (a New Basic Skill) 
o Youth can help write captions for other people’s display-worthy images 
o Youth can work together to create a caption that compares two views of the 

same object, or that relates an image to a poem 
• Rewards youth for good work (both image processing and caption writing) 

o Only images with good captions or interpretation get displayed 
o Facilitator can nominate images/captions to the board 
o Youth can give “shout outs” to their peer 

• Encourages/motivates youth to create display-worthy images and captions 
• Reduces the amount of work required during the final weeks of the program 

o Bulk of images are pre-chosen 
o Youth need only to reorganize 
o Captions can be edited rather than re-created 
o Provides a model of what an exhibit display board should look like 

• Provides a public display for group-created AstroCreative projects (i.e. poems, photos 
of sculptures) that may not make it into youth’s own exhibit displays 

 
What form should this take? 
 

Best option: Print out the best images and captions each week and add them to an exhibit 
display board that is updated weekly.  
• Pro: provides a physical place where youth can watch the exhibit develop 
• Con: Requires weekly access to a color printer 
 

Backup option: Create a digital display of the electronic images that gets updated each 
week (e.g. Flickr or other online photo album program, PowerPoint or “Best Of” folder on 
the facilitator’s “master computer”) 
• Pro: Does not require weekly access to a color printer 
• Con: Does not have a concrete connection to the physical display 
 
If an electronic photo album is created, the facilitator can print out the chosen images 
when it is time to assemble the final exhibition. Either way, the resulting exhibit board that 
the group creates will become an introductory panel in the final exhibition and model for 
the youth what the boards should look like. 
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How should the board/album be organized? 
 

Images and accompanying captions can be posted with no particular organization in mind, 
or the facilitator can provide some overarching guidance. We recommend: 
 

• Divide the board into five sections, one for each week 
• Divide the board into categories that relate to specific program content 

o Processing tools/activities (changing contrast, astro-poetry, etc.) 
o Astronomical objects (Moon, planets, stars, nebulae, galaxies) 

• Other, at the facilitators’ and youth’s discretion 
 

Although black-and-white placeholder images can be used, most of the youth’s excitement 
comes from seeing the full color versions of their images. 
 
When should images and accompanying information be added? 
 

Option 1: Youth and facilitators nominate and select images for the board during the 
processing challenge reflection period. A facilitator prints those images and captions out 
while other activities are going on, and adds them to the board during closing circle. 
 

Option 2: Youth and facilitators nominate and select images for the board during the 
reflection time and/or closing circle. A facilitator prints them out during the week and adds 
them to the board at the following week’s opening circle. 
 

Option 3: A facilitator prints out all “display-worthy” images and captions during the week 
and youth choose which ones to display during opening circle the following week. 
 
It is up to the facilitators how and when this display will be created. The main goal is 
for youth to see throughout the program how their work is becoming a part of a real 
exhibition.  
 
Template for activity write-up appears on Page 12 of this curriculum. Be sure to add this 
activity to each week’s lesson plan! 
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Weekly Lesson Plans 
 
KCU Program Advertisement 
• Strategies for Engaging Youth 

 
Week 1: Introduction to Telescopes and Images 
• Look Through a Telescope/Kinesthetic Telescope 
• Processing Challenge: The Prudential Tower 
 
Week 2: The Moon, Planets, and Our Solar System 
• Processing Challenge: The Moon (sharpen, zoom, crop) 
• Astro-Creative Challenge: Astro-Poetry 
 
Week 3: Stars and Nebulae in our Milky Way galaxy 
• Processing Challenge: Orion Nebula, Hercules Star Cluster 
• Astro-Creative Challenge: Kinesthetic Life Cycle of Stars 
 
Week 4: Galaxies Outside the Milky Way 
• Processing Challenge: Whirlpool Galaxy 
• Astro-Creative Challenge: Astro-Sculpture 
 
Week 5: Field Trip 
 
Week 6: Prepare Exhibit Materials 
• Image Processing and Selection 
• Final Image Caption Writing 
 
Week 7: Exhibit Component Construction 
• Group Selection and Planning 
• Creative Component Construction 
• Final Resources Assembled 
 
Week 8: Final Exhibit Construction 
• Exhibit Displays Assembled 
• Introduction to Visitor Conversations 
 
Week 9: Prepare and Practice Presentations 
• Prepare Presentations and Demonstrations 
• Practice Presenting and Provide Feedback 
 
Week 10: Final Preparation for astrophotography exhibit 
 
Week 11: Optional Reflection 
 
Supplemental Activities: Making Images, Images from Telescopes, False Color Tables 
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Activity Name: KCU Program Advertisement Time: 5 minutes  

 

 
DO AN ACTIVITY 
 
Image Processing Demonstration 
• Open an image 
• Open “Adjust Image” tool 
• Hit “Auto” 
• Change the color table (let youth choose which 

colors to try) 
 
Astropoetry Demonstration 
• Show a beautiful image of an astronomical object 
• Ask youth what words they would use to describe 

it. What does it remind them of? 
• Write the words on index cards or Post-Its 
• Shuffle them around to create a poem 
 
EXPLAIN THE PROGRAM 
 
• Show youth the telescopes they will be using 
• Describe the program and astrophotography 

exhibit, being sure to include examples of youth 
creations 

• Ask for questions 
 

Objective 
 
 
To entice youth to enroll in the astronomy 
program 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You may wish to assure youth that this 
program is not for “science geeks only.” It 
involves computers and creative arts 
projects.  

 

 
The following template should be filled out by the facilitator  and included in each week’s 
lesson plan for the first half of the program. 
 

Activity Name: Image Wall/Exhibit Board Time: 5 minutes  

 

 
Use this template to fill in your specific strategy for 
creating a model astrophotography exhibit board or 
electronic photo album. Exact procedure will depend 
on your specific resources and program. See the 
“Guide to the Image Wall” on pages 8 and 9 of the 
curriculum for suggestions. 
 

Objective 
 
 
To create an ongoing display of youth’s 
accomplishments 
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Week 1 (With Telescope) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Get to know each other and the Facilitator 
2. Take at least one image of a Moon or planet with MicroObservatory telescope 

 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. How a telescope works 
2. How to take images with the MicroObservatory telescopes 
3. How to open and save images with the image processing software 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Survey & Get To Know You Icebreaker 
2. Review Agenda and exhibit format 
3. Activity: Looking Through a Telescope 
4. BREAK 
5. Take Images: Moon, Planets 
6. Activity:  Introduction to Image Information 
7. Processing Challenge: Prudential Tower 
8. Closing Circle 

15 Minutes 
5 Minutes 
15 Minutes 
5 Minutes 
10 Minutes 
10 Minutes 
20 Minutes 
10 Minutes 
 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Make sure software is installed and running on the computers 
Load challenge images into appropriate folder on the computer 
Create youth’s processed images folder on each machine 
Set up telescope  
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the youth 
to see. 
 
Focus Vocabulary (to be posted): Telescope, image, pixel, brightness, image processing 
Additional Vocabulary (to be aware of): Exposure time, aperture, mirror, shutter, detector 
 

Materials and Equipment 
 
Physical resources: Survey, writing utensils, observing logs, empty portfolio folders, vocabulary 
 
Electronic resources: Stock challenge image (TowerChallenge.FITS) 
 
Computing resources: Image processing software, Internet browser, folders set up on computer 
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Week 1 Icebreaker: A Big Wind Blows Time: 10 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (1 minute) 
 
• All youth stand in a circle with the facilitator in the center. 

Use chairs or desks to mark each youth’s place in the 
circle. 

 
• The person in the middle says. “My name is [name] and I 

[something that is true about me]. (E.g. am wearing 
sneakers, have brown hair) 

 
• Everyone else for whom that fact is also true (e.g. 

everyone who is wearing sneakers or has brown hair) 
leaves their spot and tries to find a new spot. The person 
in the middle takes someone else’s spot.  

 
• The person who is left without a spot is in the middle 
 
DO THE ACTIVITY 
 
• Repeat the process above, being sure to include facts that 

cannot be seen just by looking at people (e.g. “is an only 
child,” “used to live in another state,” “likes basketball”) 

 
DISCUSS THE ACTIVITY 
 
• Astronomers make observations of objects in space, using 

telescopes and other tools. 
 
• Some properties of an object can be observed just by 

looking at them (shape, brightness, etc.). Others need 
more information to explain what they are like (what they 
are made of, how they move, etc.) 

 
• In this program, we will be making observations of objects 

in space and learning more about them through activities 
and research. 

 

Objective 
 
To get to know each other 
 
To begin thinking about how to 
describe objects 
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Week 1 Activity: Looking Through a Telescope Time: 15 minutes 

 

Procedure 

 
PREPARE THE ACTIVITY 
 
• Set up a telescope outside, if possible, or in a long 

hallway or classroom. Point the telescope at the 
Moon or an object on Earth that is far enough away 
that its details cannot be resolved. 

 
DO THE ACTIVITY 
 
• Hand out paper to each youth and instruct them to 

split it into three sections—two large sections next to 
each other at the top, and one smaller section at the 
bottom (see example, right) 

 
• In one section, youth sketch the object as it appears 

to them standing next to the telescope 
 
• In the second section, youth sketch the object as it 

appears to them looking through the telescope 
 
• In the third section, youth write a caption explaining 

what they expected to see, what they saw, and how 
the two views compare 

 
DISCUSSION 
 
• What do telescopes do? (They show us more detail 

in objects that are far away) 
 
• Youth can share their captions if desired 
 

Objective 
 
To look through a telescope 
 
To compare naked eye views with 
telescopic views 
 
 
 
 
 
 
Example of observation page: 
 

Section 1 (view 
without telescope) 
 
 
 
 

Section 2 (view  
with a telescope) 

Section 3 (caption explaining 
expectations and observations) 
 
 
 
 
 
  

 
     Materials Needed: Telescope, paper, pens/pencils 
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Week 1: Request images from MicroObservatory Time: 10 minutes      

 

 
• Week 1: facilitator models how to request an image 

using the Guest Observer Portal and record the 
request in the Observation Log 

 
HOW TO REQUEST AN IMAGE 
 
• Open Internet browser 
• Go to www.microobservatory.org 
• Choose an activity (see list below) 
• Choose an object 
• Choose an exposure time (faint objects require 

longer exposure times) 
• Enter an email address (easy option is to use 

account created and monitored by facilitator, see 
page 6)  

• Record request in observing log 
• Confirm request 
 

Objective 
Take images of the Moon and 
planets for next time. 
 
 
 

 

Hint: It will save you time if you write the URL on the board for youth to see  
    (it is also written on their observing logs) 

 
Note: The automated emails from the MicroObservatory server are sent around 1 p.m. the day 

AFTER images are requested.  
 

 
Where will youth find the various telescope targets they need? 
Look within the following Guest Observer Portal activities to find the desired targets 
 
• Moon (Telescope As Time Machine, Galileo) 
• Planets (Galileo, Telescope As Time Machine) 
• Stars & Star Clusters (Galileo, Telescope As Time Machine) 
• Nebulae (Colorful Cosmos, Black Hole Hunt) 
• Galaxies (Galaxies Galore, Black Hole Hunt) 
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Week 1 Activity:  Introduction to image information Time: 10 minutes 

 

 
INTRODUCTION (Open and Explore the Image) 
 

Youth do each action along with the facilitator 
 

1. Open the image processing software 
 

2. Click “File” > “Open image on local disk…” and 
choose the image from the appropriate folder 
(TowerChallenge.FITS) 

 

3. Click “Window” > “Image Info” 
 

4. Move cursor over the image and notice the 
changes in the Image Info window. Three 
possible answers. The third being the one to 
focus on: 

a. The picture in the view box changes  
b. The numbers next to “X” and “Y” change 
c. The number next to the word “Pixel” 

changes 
 

5. Explain what is going on. Again, answer “c” is the 
one to focus on. 

a. The view box allows us to see a closer 
view of the object 

b. The numbers next to “X” and “Y” tell us 
where we are in the image 

c. The “Pixel Value” number tells how bright 
that part of the image appears, or how 
much light is coming from that part of the 
object 

 

6. CHALLENGE: Where in the image is the pixel 
value the highest? What value does it have? 
Where is it lowest? 

 

7. OPTIONAL EXPLORATION: How can youth get a 
better view of the individual pixels? (Answer: 
zoom tool—the magnifying glass icon at the top of 
the image) 

 

Objective 
 
 
Learn how to open an image on the 
computer 
 
Use the mouse and “Image Info” 
window to get information about the 
image. 
 
(Optional) Use the zoom tool to see 
the pixels more closely 
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Week 1 Processing Challenge:  Prudential Tower 
(Quick reference available on page C-2 of the curriculum) 

Time: 20 minutes  
(including reflection) 
 

 
MODEL THE ACTIVITY 
 

Youth do each step along with the facilitator to achieve 
the activity goal: To increase the contrast between 
the windows on the left side of the building and 
the building itself. 
 

1. Re-open the image TowerChallenge.FITS or return 
it to its original view by double clicking on the 
magnifying glass icon to zoom all the way out 

 

2. Make sure the “Image Info” window is open 
 

3. Click “Process” > “Adjust Image…” 
 

4. Point out the “Max” and “Min” fields in the “Adjust 
Image” window and explain that changing these 
numbers changes the appearance of the image. 

 

5. Explain that you want to make the windows on the 
left side of the building appear white against a 
black background. 

 

6. Click on the main image window, and note in the 
“Image Info” window the approximate pixel value of 
the area that you want to appear white—windows.  

 

7. Enter that value (300) into the “Max” field (be sure 
to hit enter). 

 

8. Click on the main image window, and note in the 
“Image Info” window the approximate pixel value of 
the area of the image that you want to appear 
black—the surrounding building.  

 

9. Enter that value (275) into the “Min” field (be sure 
to hit Enter). 

 

10. Click on “File” > “Save Image As…” > “GIF” and 
choose the folder to save it in (e.g. “Week 1”) 

 

11. Save the file with a descriptive file name (e.g. 
NameTowerDate.GIF) 

 
 
What’s Going On? 
 

• Any pixel with a value greater than or equal to the 
Maximum value will appear white in the image 

• Any pixel with a value less than or equal to the 
Minimum value will appear black in the image 

• Pixel with values in between the Minimum and 

Objective 
 
 
Learn how to change the contrast of an 
image using the “Adjust Image” tool. 
 
(Optional) Learn how to use false color 
tables to change the appearance of an 
image 
 
Learn how to save images with 
descriptive file names. 
• Object name 
• Youth name 
• Descriptive feature such as date or 

color of processing 
• File extension (.GIF) must be added 

explicitly. 
 
 
 
Additional Information: 
 
At the end of this activity, youth should 
reopen the program and the image to 
make they can find and access the 
image on their computer. If a file is not 
saved as a GIF with a .GIF extension, 
it will not open! 
 
 
Astrophotography exhibit Goal: 
 
Practice articulating your personal 
connection to the images you create. 
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What’s Going On? 
 

• Any pixel with a value greater than or equal to the 
Maximum value will appear white in the image 

• Any pixel with a value less than or equal to the 
Minimum value will appear black in the image 

• Pixel with values in between the Minimum and 
Maximum will appear some shade of gray 

• Changing the display does NOT change the actual 
information in the image, just how it appears to the 
person looking at it 

 
CHALLENGE 
 

Once youth have successfully recreated Tower1.GIF 
they should move on to the Challenge. Youth should 
try to figure out the steps on their own, but for this first 
challenge, facilitators should be prepared to prompt 
and guide youth through the specific actions: 
 

1. Show the processed image (Tower2.GIF) and 
identify the goal: Make the name of the building 
appear white with a black background. 

 

2. Open the image to be processed  
 

3. Set “Max” value to match approximate pixel value 
of the letters in the word “PRUDENTIAL” (~500) 

 

4. Set “Min” value to match approximate pixel value 
of the building around the word “PRUDENTIAL” 
(~350) 

 

5. Save image with a unique, descriptive name (don’t 
forget .GIF at the end!) 

 
 
REFLECTION (Caption-writing and/or discussion) 
 

6. Which view(s) of the Tower do you like best? Why? 
 

This reflection helps youth prepare for their final 
exhibit by creating a label for a chosen image: Why 
did you choose to put this image in your exhibit? What 
should visitors know about how it was made? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once youth have completed the 
challenge, they may change the color 
table of their image, and save a new 
version as a GIF with an appropriate 
descriptive name. See the Processing 
Challenge: Color Tables for an in-depth 
presentation of this tool and reflection 
activity. 
 
 
NOTE: Some facilitators may wish 
simply to introduce the color tables as 
an add-on, rather than a separate 
activity. 
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Week 1 (Without A Telescope) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Get to know each other and the Facilitator 
2. Take at least one image of a Moon or planet with MicroObservatory telescope 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. How a telescope works 
2. How to take images with the MicroObservatory telescopes 
3. How to open and save images with the image processing software 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Survey & Get To Know You Icebreaker 
2. Review Agenda and Astrophotography exhibit 

format 
3. Kinesthetic Telescope 
4. BREAK 
5. Take Images: Moon, Planets 
6. Activity:  Introduction to Image Information 
7. Processing Challenge: Prudential Tower 
8. Closing Circle 

15 Minutes 
5 Minutes 
15 Minutes 
5 Minutes 
10 Minutes 
10 Minutes 
20 Minutes 
10 Minutes 
 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Make sure software is installed and running on the computers 
Load challenge images into appropriate folder on the computer 
Create youth’s processed images folder on each machine 
Prepare kinesthetic telescope cards and narration (Appendix E) 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
Focus Vocabulary (to be posted): Telescope, image, pixel, brightness, image processing 
Additional Vocabulary (to be aware of): Exposure time, aperture, mirror, shutter, detector 
 

Materials and Equipment 
 
Physical resources: Survey, writing utensils, observing logs, empty portfolio folders, 
vocabulary, kinesthetic telescope cards and narration (Appendix E) 
 
Electronic resources: Stock challenge images (TowerChallenge.FITS) 
 
Computing resources: Image processing software, Internet browser, folders set up on 
computer 
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Week 1 Icebreaker: A Big Wind Blows Time: 10 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (1 minute) 
 
• All youth stand in a circle with the facilitator in the 

center. Use chairs or desks to mark each youth’s 
place in the circle. 

 
• The person in the middle says. “My name is [name] 

and I [something that is true about me]. (E.g. am 
wearing sneakers, have brown hair) 

 
• Everyone else for whom that fact is also true (e.g. 

everyone who is wearing sneakers or has brown hair) 
leaves their spot and tries to find a new spot. The 
person in the middle takes someone else’s spot.  

 
• The person who is left without a spot is in the middle 
 
DO THE ACTIVITY 
 
• Repeat the process above, being sure to include facts 

that cannot be seen just by looking at people (e.g. “is 
an only child,” “used to live in another state,” “likes 
basketball”) 

 
DISCUSS THE ACTIVITY 
 
• Astronomers make observations of objects in space, 

using telescopes and other tools. 
 
• Some properties of an object can be observed just by 

looking at them (shape, brightness, etc.). Others need 
more information to explain what they are like (what 
they are made of, how they move, etc.) 

 
• In this program, we will be making observations of 

objects in space and learning more about them 
through activities and research. 

 

Objective 
 
To get to know each other 
 
To begin thinking about how to 
describe objects 
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Week 1 Activity: Kinesthetic Telescope Time: 15 minutes 

(More information/materials in Appendix E) 

Procedure 

 
MODEL THE ACTIVITY (5 minutes) 
 
• Facilitator reviews the vocabulary describing different 

parts of a telescope 
 
• Ask for volunteers to be each part of the telescope. 

Some parts (e.g. aperture) will need multiple people 
to create an appropriate formation 

 
• Set up the youth in the appropriate formation and 

designate one as a beam of light coming from an 
object in outer space. 

 
• Walk the beam through the telescope, narrating what 

happens to the light at each stage 
 
DO THE ACTIVITY (10 minutes) 
 
• Youth create their own model of the process, or 

recreate the process they just saw. Non-telescope 
youth can be beams of light, objects in space, or 
astronomers at the detector end of the telescopes. 

 
• Each part of the telescope must explain what he or 

she is doing. The light cannot move forward until it is 
given permission from the telescope 

 
o Light: travels from objects in space to the 

telescope 
o Aperture: lets the light into the telescope 
o Mirror: focuses the light toward the detector 
o Shutter: lets the light through to the detector 
o Detector: records the light to create an image 

 

Objective 
 
To learn/review how light travels 
through a telescope 
 
To learn/review what different 
parts of the telescope does 
 
To work together as a team to 
create a human telescope 

 
Materials Needed: Narration of the process, telescope vocabulary words 
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Week 1: Request images from MicroObservatory Time: 5 minutes      

 

 
• Week 1: facilitator models how to request an 

image using the Guest Observer Portal and 
record the request in the Observation Log 

 
HOW TO REQUEST AN IMAGE 
 
• Open Internet browser 
• Go to www.microobservatory.org 
• Choose an activity (see list below) 
• Choose an object 
• Choose an exposure time (faint objects require 

longer exposure times) 
• Enter an email address (easy option is to use 

account created and monitored by facilitator, 
see page 6)  

• Record request in observing log 
• Confirm request 
 

Objective 
Take images of the Moon and 
planets for next time. 
 
 
 

 

Hint: It will save you time if you write the URL on the board for youth to see  
    (it is also written on their observing logs) 

 
Note: The automated emails from the MicroObservatory server are sent around 1 p.m. the 

day AFTER images are requested.  
 
Where will youth find the various telescope targets they need? 
Look within the following Guest Observer Portal activities to find the desired targets 
 
• Moon (Telescope As Time Machine, Galileo) 
• Planets (Galileo, Telescope As Time Machine) 
• Stars & Star Clusters (Galileo, Telescope As Time Machine) 
• Nebulae (Colorful Cosmos, Black Hole Hunt) 
• Galaxies (Galaxies Galore, Black Hole Hunt)



Kids Capture Their Universe: An Astronomy Out-of-School Program 
 

The “Kids Capture Their Universe” (KCU) astronomy program was developed  
by MIT Kavli Institute (MKI) and the Smithsonian Astrophysical Observatory (SAO),  
in partnership with Citizen Schools, Boston.  

 

25 

 

Week 1 Activity:  Introduction to image information Time: 10 minutes 

 

 
INTRODUCTION (Open and Explore the Image) 
 

Youth do each action along with the facilitator 
 

1. Open the image processing software 
 

2. Click “File” > “Open image on local disk…” and 
choose the image from the appropriate folder 
(TowerChallenge.FITS) 

 

3. Click “Window” > “Image Info” 
 
4. Move cursor over the image and notice the changes 

in the Image Info window. Three possible answers. 
The third being the one to focus on: 

a. The picture in the view box changes  
b. The numbers next to “X” and “Y” change 
c. The number next to the word “Pixel” changes 

 
5. Explain what is going on. Again, answer “c” is the 

one to focus on 
a. The view box allows us to see a closer view of 

the object 
b. The numbers next to “X” and “Y” tell us where 

we are in the image 
c. The “Pixel Value” number tells how bright that 

part of the image appears, or how much light 
is coming from that part of the object 

 

6. CHALLENGE: Where in the image is the pixel value 
the highest? What value does it have? Where is it 
lowest? 

 

7. OPTIONAL EXPLORATION: How can youth get a 
better view of the individual pixels? (Answer: zoom 
tool—the magnifying glass icon at the top of the 
image) 

 

Objective 
 
 
Learn how to open an image on the 
computer 
 
Use the mouse and “Image Info” 
window to get information about the 
image. 
 
(Optional) Use the zoom tool to see 
the pixels more closely 
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Week 1 Processing Challenge:  Prudential Tower 
(Quick reference available on page C-2 of the curriculum) 

Time: 20 minutes  
(including reflection) 
 

 
MODEL THE ACTIVITY 
 

Youth do each step along with the facilitator to achieve 
the activity goal: To increase the contrast between 
the windows on the left side of the building and the 
building itself. 
 

1. Re-open the image TowerChallenge.FITS or return it 
to its original view by double clicking on the 
magnifying glass icon to zoom all the way out 

 

2. Make sure the “Image Info” window is open 
 

3. Click “Process” > “Adjust Image…” 
 

4. Point out the “Max” and “Min” fields in the “Adjust 
Image” window and explain that changing these 
numbers changes the appearance of the image. 

 

5. Explain that you want to make the windows on the 
left side of the building appear white against a black 
background. 

 

6. Click on the main image window, and note in the 
“Image Info” window the approximate pixel value of 
the area that you want to appear white—windows.  

 

7. Enter that value (300) into the “Max” field (be sure to 
hit enter). 

 

8. Click on the main image window, and note in the 
“Image Info” window the approximate pixel value of 
the area of the image that you want to appear 
black—the surrounding building.  

 

9. Enter that value (275) into the “Min” field (be sure to 
hit Enter). 

 

10. Click on “File” > “Save Image As…” > “GIF” and 
choose the folder to save it in (e.g. “Week 1”) 

 

11. Save the file with a descriptive file name (e.g. 
NameTowerDate.GIF) 

 

Objective 
 
 
Learn how to change the contrast of 
an image using the “Adjust Image” 
tool. 
 
(Optional) Learn how to use false 
color tables to change the 
appearance of an image 
 
Learn how to save images with 
descriptive file names. 
• Object name 
• Youth name 
• Descriptive feature such as date 

or color of processing 
• File extension (.GIF) must be 

added explicitly. 
 
 
 
Additional Information: 
 
At the end of this activity, youth 
should reopen the program and the 
image to make they can find and 
access the image on their computer. 
If a file is not saved as a GIF with a 
.GIF extension, it will not open! 
 
 
Astrophotography exhibit Goal: 
 
Practice articulating your personal 
connection to the images you create. 
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What’s Going On? 
 

• Any pixel with a value greater than or equal to the 
Maximum value will appear white in the image 

• Any pixel with a value less than or equal to the 
Minimum value will appear black in the image 

• Pixel with values in between the Minimum and 
Maximum will appear some shade of gray 

• Changing the display does NOT change the actual 
information in the image, just how it appears to the 
person looking at it 

 
CHALLENGE 
 

Once youth have successfully recreated Tower1.GIF 
they should move on to the Challenge. Youth should try 
to figure out the steps on their own, but for this first 
challenge, facilitators should be prepared to prompt and 
guide youth through the specific actions: 
 

1. Show the processed image (Tower2.GIF) and 
identify the goal: Make the name of the building 
appear white with a black background. 

 

2. Open the image to be processed  
 

3. Set “Max” value to match approximate pixel value of 
the letters in the word “PRUDENTIAL” (~500) 

 

4. Set “Min” value to match approximate pixel value of 
the building around the word “PRUDENTIAL” (~350) 

 

5. Save image with a unique, descriptive name (don’t 
forget .GIF at the end!) 

 
 
REFLECTION (Caption-writing and/or discussion) 
 

6. Which view(s) of the Tower do you like best? Why? 
 

This reflection helps youth prepare for their final exhibit 
by creating a label for a chosen image: Why did you 
choose to put this image in your exhibit? What should 
visitors know about how it was made? 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once youth have completed the 
challenge, they may change the color 
table of their image, and save a new 
version as a GIF with an appropriate 
descriptive name. See the 
Processing Challenge: Color Tables 
for an in-depth presentation of this 
tool and reflection activity. 
 
 
NOTE: Some facilitators may wish 
simply to introduce the color tables 
as an add-on, rather than a separate 
activity. 
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Week 2 (Objects in Our Solar System) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Process and save at least one image of the Moon (with caption!) 
2. Create an astronomy poem 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. How to use the sharpen and zoom tools 
2. How to make detailed observations 
3. What sorts of words can help people understand astronomy images 
4. Information about objects in our solar system 
 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: What’s Different? Icebreaker 
2. Review Agenda and Introduce Vocabulary 
3. Processing Challenge: Moon 
4. Take images: Nebulae, Stars 
5. BREAK 
6. Creative Challenge: Astro Poetry 
7. Closing Circle 

10 Minutes 
5 Minutes 
25 Minutes 
5 Minutes 
5 Minutes 
25 Minutes 
15 Minutes 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Make sure software and processed images are still on computers 
Retrieve youth’s requested images from last week and load them onto the computers 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the youth 
to see. 
 
Focus Vocabulary: Moon, Planet, Our Solar System, Zoom 
Additional Vocabulary: Crater, Sharpen, Crop, False Color Table 
 

Materials and Equipment 
 
Physical resources: Observing logs, processing logs, index cards, markers, astronomical 
images  
 
Electronic resources: Moon & planet images requested last week, Stock Moon challenge image 
(MoonChallenge.FITS) 
 
Computing resources: Electronic folders, processing software, Internet browser on each 
computer 
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Week 2 Icebreaker: Noticing Detail – What’s different? Time: 10 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (2 minutes) 
 
• All youth line up facing the front of the classroom. 

facilitator stands facing the youth. 
 
• Youth examine the facilitator and observe as many 

things about his/her appearance as they can. 
 
• After 30 seconds, youth turn around to face the back of 

the classroom while the facilitator changes a small but 
noticeable feature on his/her person (e.g. takes off 
name tag, rolls up shirt sleeve, changes hair style) 

 
• When given the “all clear” by the facilitator, youth turn 

around and try to identify what has changed. 
 
DO THE ACTIVITY (6 minutes) 
 
• The person who correctly identifies the change 

becomes the next person to make a change. 
 
• Repeat until everyone has had a turn 
 
DISCUSS THE ACTIVITY (2 minutes) 
 
• Astronomers must notice details in images and make 

very careful observations to determine what objects are 
like and how they change. 

 
• In this program, youth will be examining images of their 

own and explaining to their audience what they observe. 
 

Objective 
 
To begin looking carefully at 
objects being observed 
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Week 2 Processing Challenge: The Moon 
(Quick reference available on page C-3 of the curriculum) 

Time: 25 minutes  
(including reflection) 

 

 
INTRODUCTION 
 

1. Review how to open the software, images, and 
image windows (Image Info, Adjust Image) 

 

2. Open image MoonChallenge.FITS 
 

3. Explain the goal of the activity: To get a better, 
more detailed view of a chosen crater on the 
surface of the Moon 

 
MODEL ACTIVITY (youth follow along) 
 

1. Click “Process” > “Sharpen” 
 

2. Click on the ‘zoom’ tool (magnifying glass) 
 

3. Click on the crater to be observed (middle of image) 
 

4. Adjust the contrast on the image in the by moving 
the triangles in the “Adjust Image” window 

 

5. Demonstrate the use of color tables and re-adjust 
the contrast if necessary/desired. 

 

6. Once the image looks how you want it, click on the 
‘select area’ tool (dotted rectangle) 

 

7. Select the area to be cropped by clicking on one 
corner of the desired area and dragging the mouse 
to the opposite corner and then releasing 

 

8. Click “Process” > “Crop” 
 

9. Save the new image as a GIF file with a descriptive 
name 

 
Note: Cropping should always be the LAST thing that 
you do before saving an image. The cropped image will 
open up in a new window and the zoom tool will not 
work the same way as it does in the original. 
 

Objective 
 
Review how to open and save an 
image. 
 
Learn how to zoom in on an image 
 
Learn how to crop an image 
 
Practice using the “Adjust Image” 
tool to change the contrast of an 
image in a new way 
 
Learn how to sharpen an image 
 
Apply color tables to change the 
appearance of an image 
 
 
Additional Information 
 
The Sharpen tool is rarely used for 
processing images other than the 
Moon. As such, it may be skipped. 
 
Because the color tables are so 
popular, youth will likely have 
discovered them during the first 
week of processing challenges. If 
they have not, introduce them as an 
add-on this week. 
 
 
Astrophotography exhibit Goals: 
 
Use teamwork to communicate 
information about an image to an 
audience. 
 
Practice writing captions. 
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YOUTH CHALLENGE  
 

The challenge is presented in gray scale so that youth 
can focus on the contrast, zooming, and cropping tools. 
Color tables can be added later. 
 

1. Show the processed image (Moon2.GIF) and identify 
the goal: Create a sharp detailed view of craters 
at the bottom of the Moon 

 

2. Prompt and assist youth in figuring out how to 
complete the challenge on their own/in pairs.  

 

3. Sharpen the image 
 

4. Zoom in on the chosen area 
 

5. Adjust the contrast by moving the triangles/changing 
the “Min” and “Max” values in the “Adjust Image” 
window. 

 

6. Select and crop the chosen area of the image 
 

7. Save the cropped image as a GIF file 
 
OPTIONAL CHALLENGE/FREE PROCESSING 
 

If desired, create another challenge image with a false 
color table. See “Color Tables” challenge for more info. 
 

1. Experiment with the various tools (including color 
tables) using the telescope images requested last 
week. 

 

2. Save all processed images as GIF files with unique, 
descriptive names, and record in the processing log 
how you made each image. 

 
REFLECTION (Caption-writing/gallery interviews) 
 

1. Look at another image that has been created. 
Interview the person who created it. How did they 
make it? What do they like about it?  

 

2. Prepare a caption for your partner’s image and share 
it with the group 

 

 
 
 
 
 
 
 
 
 
 
 
 

Steps 3-6 are listed for the 
facilitator’s reference only—youth 
must make a good faith effort to 
figure things out before facilitators 
reveal the “answers.” 
 
NOTE: Youth do not need to match 
the contrast settings exactly, but for 
reference, the “Min” and “Max” 
values in the presented image were 
set to match the pixel values of the 
background (~280) and bright spots 
on the surface (~550). 
 
 
 
 
 
 
 
 

With limited time, it is tempting to 
skip the caption-writing part of the 
exercise, but this will be a key 
element of the final projects.  
 
The interview model is useful 
because it helps youth articulate 
what they or other people did to 
create an image. During the final 
Astrophotography exhibit, youth will 
be responsible for presenting each 
other’s images as well as their own. 
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Week 2: Request images from MicroObservatory Time: 5 minutes      

 

 
HOW TO REQUEST AN IMAGE 
 
• Open Internet browser 
 
• Go to www.microobservatory.org 
 
• Choose an activity (see list below) 
 
• Choose an object 
 
• Choose an exposure time (faint objects require 

longer exposure times) 
 
• Enter an email address (easy option is to use 

account created and monitored by facilitator, see 
page 6)  

 
• Record request in observation log 
 
• Confirm request 
 

Objective 
Take images of stars and nebulae 
for next time. 
 
 
 
Hint: 
It will save you time if you write the 
URL on the board for youth to see (it 
is also written on their observing 
logs) 

 

 

Telescope Targets (Guest Observer Portal Activity Locations) 
 
• Moon (Telescope As Time Machine, Galileo) 
 
• Planets (Galileo, Telescope As Time Machine) 
 
• Stars & Star Clusters (Galileo, Telescope As Time Machine) 
 
• Nebulae (Colorful Cosmos, Black Hole Hunt) 
 
• Galaxies (Galaxies Galore, Black Hole Hunt) 
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Week 2 Creative Challenge: AstroPoetry Time: 20 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (facilitator)  (5 minutes) 
 
• Facilitator shows an astronomical image taken by a 

professional or amateur astronomer/astrophotographer.  
 
• Ask youth what they know about the image and what 

words they would use to describe it (e.g. bright, swirling) 
or what it reminds them of (e.g. marble, pancake, hula 
hoop). 

 
• Facilitator records one word per index card. 
 
• Facilitators rearrange words to create a poem and read 

the poem aloud. 
 
DO THE ACTIVITY (Youth) (15 minutes) 
 
• Split into two teams—each team is given/chooses an 

astronomical image about which to create their poem 
 
• 5 minutes to brainstorm words (include nouns, verbs, 

and adjectives!) 
 
• 5 minutes to create poem (can add in connecting words 

if desired, or add pre/suffixes to existing words) 
 
• 5 minutes to share & reflect 
 

Objective 
 
To notice details in an 
astronomical image. 
 
To creatively express what is 
known objects in space. 

 
Materials needed: Index cards, markers, astronomical images 
 
Other notes:  
• Groups can compete to make the most descriptive poem about the same object, or 

they can each work on a different object (chosen or assigned) 
• Poems can include astronomical information if it is known 
• Youth should practice good oral presentation skills when they present their poems—

speaking slowly, loudly, and clearly, while showing their image with the poem. 
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Week 3 (Stars and Nebulae) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Process and save at least one image of a nebula (with caption!) 
2. Work together to create kinesthetic models 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. What stars and nebulae are 
2. How the “Adjust Image…” tool changes the contrast of an image 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Human Machines Teambuilding 
2. Review Agenda and Introduce Vocabulary 
3. Processing Activity: Orion Nebula 
4. Processing Challenge:  Star Cluster 
5. Take images: Galaxies 
6. BREAK 
7. Creative Challenge: Kinesthetic Astronomy 
8. Closing Circle 

15 Minutes 
5 Minutes 
10 Minutes 
10 Minutes 
5 Minutes 
5 Minutes 
25 Minutes 
10 Minutes 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Retrieve youth’s requested images from last week and load them onto the computers 
Choose an open area (outside or indoors) for the kinesthetic astronomy activity 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
Focus Vocabulary: Star, Nebula, Contrast, Gravity 
Additional Vocabulary: Our Milky Way Galaxy 
 

Materials and Equipment 
 
Physical resources: Portfolio folders, observing logs, processing logs, token astronomical 
images for illustrating stellar life cycle (Appendix A) 
 
Electronic resources: Images of stars and nebulas, Stock challenge images 
(NebulaChallenge.FITS and StarClusterChallenge.FITS) 
 
Computing resources: Image processing software, Internet browser, electronic image folders 
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Week 3 Icebreaker: Human Machines (Teambuilding) Time: 15 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (5 minutes) 
 
• Facilitators work together to kinesthetically create a 

machine, such as an old-fashioned grandfather clock 
(one person is the face; the other is the pendulum) 

 
• Help the youth to create their first machine: 
 

o Computer: two youth can make the outline of a 
screen with their arms; everyone else squats 
down to become buttons on the keyboard 

 
o Microwave: two youth create the compartment, 

one youth is a rotating plate inside, others are 
buttons, plugs, etc. 

 
DO THE ACTIVITY (All together or in small groups) 
 
• Challenge youth to create other machines, such as a 

telephone, toaster, television, carousel, blender, 
bicycle, etc. (be creative…choose your own!) 

 
• Each youth becomes one part of the machine, NOT 

the humans operating it, unless necessary 
 
DISCUSS THE ACTIVITY 
 
• What was hard about this activity? (Listening to 

others, communicating your ideas, working together, 
people forgetting to do their action, etc.) 

 
• Astronomers have to share ideas and work together 

to build telescopes and interpret their data. 
 
• In this program, we will need everyone’s input to 

make our exhibit a success. If one person doesn’t do 
their part, the process won’t work! 

 

Objective 
 
To become comfortable working 
together toward a common goal. 
 
To improve communication and 
cooperation among youth. 
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Week 3 Processing Activity: Orion Nebula Time: 5-10 minutes  

(Quick reference available on page C-4 of the curriculum) 

 
MODEL THE ACTIVITY 
 
Youth follow along on their own computers, 
through both examples 
 
1. Open the image processing software and the 

image “NebulaChallenge.FITS” 
 
2. Open the “Image Info” window, and the “Adjust 

Image” window 
 
3. Point out the buttons at the bottom of the 

“Adjust Image” window (“Linear,” “Log,” “Auto”) 
and explain that these are shortcuts that we 
can use to bring out interesting parts of an 
image. 

 
 
EXAMPLE 1 (Nebula1.GIF) 
 
1. Click the “Auto” button in the “Adjust Image” 

window and ask youth to describe the resulting 
image 

 
2. Ask if anyone remembers how to set the 

background of the image to black and, at their 
prompting, or as a reminder, guide them 
through setting the “Min” field to the 
approximate pixel value of the background 
(~289) 

 
3. Point out the newly revealed features around 

the edges of the cloud (wisps of gas on the 
right, etc.) 

 
4. Crop and save image as a GIF with a 

descriptive name 
 
 
 

Objective 
 
 
Learn how to use the “Auto” and “Log” 
functions of the “Adjust Image” tool 
 
Remember how to change the contrast in 
an image, zoom, and crop 
 
 
 
 
Additional Information 
 
Because the “Auto” function is quick and 
straightforward (at least mechanically), 
two examples are given using the Orion 
Nebula image. Both examples will make 
minor adjustments to the appearance of 
the image to improve the view after using 
the “Auto” function. 
 
The challenge itself will use a different 
image, but the same procedure. 
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EXAMPLE 2 (Nebula2.GIF) 
 
1. Re-open image NebulaChallenge.FITS 
 
2. Choose “Log” and click the “Auto” button in the 

“Adjust Image” window…what do youth see? 
 
3. Explain that you want a better view of what is 

going on at the center of the nebula 
 
4. Zoom in on the center of the nebula 
 
5. Ask youth to look at the “Image Info” window 

and describe the range of pixel values in that 
area 

 
6. Set “Max” field to the highest pixel value in the 

image (~4000, at the heart of the nebula) 
 
7. Point out the newly revealed details of the cloud 

in the image (i.e. stars and texture) 
 
8. Crop and save the image as a GIF with a 

descriptive name 
 
 
What’s Going On? 
 
• Auto looks at the range of pixel values in the 

image and sets the contrast range (Min/Max) to 
display high pixel values as bright areas of the 
image and low pixel values as dark areas 

• Linear is the default scale: low pixel values 
appear darker and high values appear brighter, 
in roughly even intervals 

• Log scale is an exponential scale. It displays a 
wide range of brightness for high pixel values 
and allows you to see more details at both ends 
of the range 

• Generally, log scale is the best way to view 
images of objects like galaxies and nebulae 
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Week 3 Processing Challenge: Star Cluster Time: 10-15 minutes  

(Quick reference available on page C-5 of the curriculum) 

 
CHALLENGE 
 

Youth work independently or in pairs to figure out how to 
make StarClusterChallenge.FITS look like 
StarCluster1.GIF 
 

1. Open StarClusterChallenge.FITS, show the 
processed image (StarCluster1.GIF) and identify the 
challenge: Make visible as many stars as possible 
in the Hercules star cluster. 

 

2. Remind youth about what they did to make the 
details of the image of the Orion Nebula visible and 
use this information as prompts to complete the 
following: 

 

3. Click the “Auto” button in the “Adjust Image” window 
 

4. Set the “Min” field to the approximate pixel value of 
the background (~295) 

 

5. Click the “Log” in “Adjust Image” window 
 

6. Set “Max” field to the highest pixel value in the image 
(~950, at the center of the cluster) 

 

7. Crop and save the image as a GIF file with a 
descriptive name 

 
FREE PROCESSING AND REFLECTION 
 

Youth should process images of other objects using the 
various processing tools on their own telescope images. 
Remember to save all processed images as GIF files 
with unique, descriptive names, and record in the 
processing log each image was made. 
 

At the end of the session, everyone should discuss, 
caption, and reflect on the processed images with 
partners or in the large group. Shout-outs welcome. 
 

Objective 
 
 
Practice using the image processing 
software to bring out detail in an 
image 
 
 
 
 
 
 
Additional Information 
 
Although false color tables are not 
an explicit part of this challenge, 
youth are encouraged to experiment 
with color tables and/or the invert 
color tool in creating their final, 
saved images. 
 
 
 
 
 
 
 
 
 
 
Astrophotography exhibit Goals: 
 
To make detailed observations 
about an image 
 
To practice sharing observations 
about an image 
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Week 3: Request images from MicroObservatory Time: 5 minutes      

 

 
 
HOW TO REQUEST AN IMAGE 
 
• Open Internet browser 
 
• Go to www.microobservatory.org 
 
• Choose an activity (see list below) 
 
• Choose an object 
 
• Choose an exposure time (faint objects require 

longer exposure times) 
 
• Enter an email address (easy option is to use 

account created and monitored by facilitator, see 
page 6)  

 
• Record request in observation log 
 
• Confirm request 
 

Objective 
Take images of galaxies for next 
time. 
 
 
 
Hint: 
It will save you time if you write the 
URL on the board for youth to see (it 
is also written on their observing 
logs) 

 

Telescope Targets (Guest Observer Portal Activity Locations) 
 
• Moon (Telescope As Time Machine, Galileo) 
 
• Planets (Galileo, Telescope As Time Machine) 
 
• Stars & Star Clusters (Galileo, Telescope As Time Machine) 
 
• Nebulae (Colorful Cosmos, Black Hole Hunt) 
 
• Galaxies (Galaxies Galore, Black Hole Hunt) 
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Week 3 Creative Challenge: Kinesthetic Astronomy Time: 25 minutes 

(More information available in Appendix D) 

Procedure 

 
• Review the day’s vocabulary, explaining that stars, like 

nebulae, are made of gas and dust. They are born 
inside giant star-forming nebulae and when they die 
they leave behind other types of nebulae. Each youth 
will represent a clump of gas in the star or nebula. 

 
• Facilitator shows an astronomical image and explains 

the process that each object is going/has gone through.  
 
• Facilitator helps youth recreate that process 

kinesthetically. 
 

o Star Forming Nebula: Clumps of gas are pulled 
together by the force of gravity, forming stars 

 
o Star: Fusion in the core of a star creates an outward 

pressure that balances the force of gravity in the 
outer layers. 

 
o Planetary Nebula: The core of an ordinary star 

collapses and the outer layers drift outward into 
space. 

 
o Supernova (Remnant): The core of a very massive 

star collapses and the outer layers fall inward and 
bounce off the core and explode outward, releasing 
energy. 

 
See additional background information for a diagram of 
youth motion in each stage. 
 

Objective 
 
To learn about different types 
of nebulae 
 
To create a kinesthetic model 
of astronomical phenomena 

Materials Needed: Astronomical images and/or poster showing stellar life cycle objects 
(star-forming nebula, stars (main sequence & red giant), planetary nebula, supernova 
remnant) 
Other notes:  
• Rather than using this activity to teach about the overarching life cycle of stars, this 

approach focuses on interpreting what can be seen in images. 
• See Appendix D for detailed background information and additional resources 
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Week 4 (Galaxies) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Process and save at least one image of a galaxy (with caption!) 
2. Create a three-dimensional astronomy sculpture 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. What a galaxy is 
2. How physical perspectives affect our view of objects in space 
3. How to give clear instructions to a peer 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Blind Sculpture Challenge 
2. Review Agenda and Introduce Vocabulary 
3. Processing Challenge: Galaxies 
4. Take images: Miscellaneous 
5. BREAK 
6. Creative Challenge: Astro Sculpture 
7. Closing Circle 

15 Minutes 
5 Minutes 
25 Minutes 
5 Minutes 
5 Minutes 
25 Minutes 
10 Minutes 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Retrieve youth’s requested images from last week and load them onto the computers 
Set up work space (and supplies) for 3D model construction 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the youth 
to see. 
 
Focus Vocabulary: Galaxy, Universe, Noise, Gravity 
 

Materials and Equipment 
 
Physical resources: Portfolio folders, observing and processing logs, craft supplies (including 
clay for blind sculpture challenge), writing utensils 
 
Electronic resources: Youth’s requested images of galaxies from last week, Stock challenge 
image (GalaxyChallenge.FITS) 
 
Computing resources: Image processing software, Internet browser, electronic image folders 
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Week 4 Icebreaker: Blind Sculpture (Teambuilding) Time: 10 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (2 minutes) 
 
• Facilitator creates a sculpture by piecing together 

multiple basic shapes out of a blob of clay. 
 
• Facilitator then describes the sculpture to the TL, who 

recreates it out of another blob of clay. 
 
DO THE ACTIVITY (6 minutes) 
 
• Youth sit back-to-back and each create a sculpture 

with at least two components 
 
• Youth take turns describing their sculptures for their 

partners to recreate. 
 
• (Optional) Youth can ask clarifying questions. 
 
DISCUSS THE ACTIVITY (2 minutes) 
 
• What could your partner have said that would have 

helped you create a better replica of their sculpture? 
 
• Good science involves designing an experiment or 

project in a way that allows others to reproduce it. 
Astronomers have to be very clear about ideas and 
models so that everyone working on the project is on 
the same page. 

 
• In this program, everyone will have their own ideas 

for what they mean by the same term, and will need 
to clearly communicate what they want to happen. 
(For example, if someone says to “make a star,” does 
that mean a five-pointed object or a round ball, like 
stars in space?” 

 

Objective 
 
To practice clear communication. 
 
To practice listening and asking 
questions about what other people 
are saying. 

 
Materials: Clay 
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Week 4 Processing Challenge: Whirlpool & Other Galaxies 
(Quick reference available on page C-5 of the curriculum) 
 

Time: 25 minutes 
 

 
MODEL THE ACTIVITY (5 minutes) 
 

Because this is the final week of processing challenges, 
youth will be encouraged to review their own knowledge in 
both the activity and the challenge. 
 
1. Show youth the processed image (Galaxy1.GIF) and 

identify the challenge: To create a clear, detailed 
image of another galaxy outside of the Milky Way 

 
2. Open image GalaxyChallenge.FITS and encourage 

youth to provide step-by-step guidance on how to best 
process the image (see steps below) 

 

3. Open the “Image Info” and “Adjust Image” windows 
 

4. Choose “Log” and click the “Auto” button in the “Adjust 
Image” window 

 

5. Adjust the “Max” value by moving the upper triangle in 
the “Adjust Image” window 

 
6. Once the image looks the way the facilitator and youth 

want, announce that it is time for the final new image 
processing tool of the program. 

 

7. Click on “Process” > “Reduce Noise” to get rid of the 
background “fuzz” in the image and make the stars in 
our own Milky Way galaxy stand out clearly 

 

8. Zoom in, crop, and save the image as a GIF with a 
unique, descriptive name. 

 
What’s Going On? 
 

• The Reduce Noise tool essentially blurs the image, so 
that individual pixels in the image are blended with the 
surrounding pixels 

• This actually changes the image data (pixel values) but 
is a useful tool for helping youth distinguish between 
stars and “background fuzz” 

• Note that all individual stars in these images are inside 
our own Milky Way Galaxy 

 

Objective 
 
 
Learn how to use the “Reduce 
Noise” tool 
 
 
Apply all processing tools to the 
images taken during the program 
 
 
 
 
 
 
Additional Information 
  
For an added challenge, change 
the color table and/or invert the 
image. Can youth replicate the 
final view? 
 
 
 
 
 
 
 
Astrophotography exhibit 
Goals: 
 
To make detailed observations 
about an image 
 
To practice sharing observations 
about an image 
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CHALLENGE (10 minutes) 
 
Goal: For youth to process one of their own images 
and teach someone else how to reproduce it. 
 
1. Now that youth have learned how to use the basic tools 

of the image processing software, they are free to 
apply any or all of them to their own telescope images. 

 
2. Youth take approximately 2 minutes each to process 

one of their own images using the full suite of 
processing tools (adjust contrast, sharpen, reduce 
noise, zoom, crop, color tables, etc.) 

 
3. In pairs, take turns examining and recreating the other 

person/team’s image. 
 
4. Remember to save every processed image as a GIF 

with a unique, descriptive name. 
 
5. Together, the pairs should create captions for each 

image, using the processing log prompts 
 
 
FREE PROCESSING AND REFLECTION (10 minutes) 
 
1. With any remaining time in the session, youth continue 

to process their own telescope images 
 
2. As an additional challenge, choose two galaxies that 

look very different and process them using the same 
steps and tools.  

 
3. Be sure to leave time at the end of the session for 

shout outs and caption/image sharing 
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Week 4: Request images from MicroObservatory Time: 5 minutes      

 

 
 
HOW TO REQUEST AN IMAGE 
 
• Open Internet browser 
 
• Go to www.microobservatory.org 
 
• Choose an activity (see list below) 
 
• Choose an object 
 
• Choose an exposure time (faint objects require 

longer exposure times) 
 
• Enter an email address (easy option is to use 

account created and monitored by facilitator, 
see page 6)  

 
• Record request in observation log 
 
• Confirm request 
 

Objective 
Take images for next time (variety of 
astronomical objects). 
 
 
 
Hint: 
It will save you time if you write the 
URL on the board for youth to see (it 
is also written on their observing logs) 

 

Telescope Targets (Guest Observer Portal Activity Locations) 
 
• Moon (Telescope As Time Machine, Galileo) 
 
• Planets (Galileo, Telescope As Time Machine) 
 
• Stars & Star Clusters (Galileo, Telescope As Time Machine) 
 
• Nebulae (Colorful Cosmos, Black Hole Hunt) 
 
• Galaxies (Galaxies Galore, Black Hole Hunt) 
 

 

Note: This is the last week that youth will use the online telescopes to request images!
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Week 4 Creative Challenge: AstroSculpture 
 

Time:  25 Minutes 

Procedure 
 
MODEL THE ACTIVITY (Facilitators)  (5 minutes) 
 

• Show an image of the Moon  
 

• Hold up a paper plate and a balloon/clay ball—ask 
youth which one is a better representation of the 
object in the image and ask them to explain why. 

 

• Ask youth for ideas about how to make their chosen 
model look more like the actual object in space (draw 
on craters, make dents, sprinkle with dust, etc.) 

 

OR: Show a pre-made model of a galaxy (CD with cotton 
ball center, for example) and demonstrate how it can be 
viewed so that it looks like different MicroObservatory 
images (face-on, edge-on, close, far away). 
 
DO THE ACTIVITY (Youth) (20 minutes) 
 

• Split into small groups (2-3 youth) 
 

• Each group chooses an image taken by a professional 
or amateur astronomer/astrophotographer and creates 
a three dimensional model of the object in the photo 

 

• Facilitators help the groups by asking leading 
questions: What do you think this object feels like? Is it 
all one piece? What is it made of? What is this object 
doing? How can you represent that process? 

 

• Each group shares their model (5 minutes) 
 

Objective 
 
To explore the relationship 
between three-dimensional 
objects and two-dimensional 
images. 
 
To creatively interpret the nature 
of astronomical objects. 
 

 
Materials Needed: Astronomical images, craft supplies of different shapes (flat, round, 
pointy, etc.), textures (smooth, stretchy, gritty, soft, etc.), and appearances (shiny, 
translucent, dark, bright, etc.), craft tools (scissors, glue, tape, stapler, markers, etc.) 
 

SUGGESTIONS FOR CRAFT SUPPLIES: Colored construction paper, box of clay, cotton 
balls, yarn, fabric, netting (tulle), fiber batting, fiber batting (quilt filler), glow string, bubble 
wrap, wax paper, aluminum foil, plastic wrap, balloons, pipe cleaners, craft sticks, small 
styrofoam or squishy balls (e.g. pom-poms) of various sizes, paper plates, toilet paper 
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Week 5 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. See a telescope? 
2. See an exhibit? 
3. Meet astronomers? 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. How astronomers process images? 
2. What makes an exhibit interesting and/or effective? 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening Circle 
2. Field Trip, Part I 
3. BREAK 
4. Field Trip, Part II 
5. Closing Circle 

10 Minutes 
20 Minutes 
5 Minutes 
20 Minutes 
5 Minutes 

Preparation and Space Set up: 
 
Depends on field trip 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
Depends on field trip 
 

Materials and Equipment 
 
Physical resources: Depends on field trip…paper and writing utensils for taking notes? 
 
Electronic resources: Depends on field trip…astronomical images? 
 
Computing resources: Depends on field trip…image processing tools? 
 

 

See next page for suggestions of possible field trip destinations
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Field Trip Ideas for Week 5 (could be week 4 or 6 if desired; adjust schedule accordingly) 
 

The purpose of the field trip is to give youth an experience with /exposure to the authentic 
work of adults which is reflected in the work of the program. 
 
Obviously, we encourage you to share more directly what you do in your profession or 
vocation, which has some connection to what the youth do during “Kids Capture Their 
Universe” 
 
Ideas (some tried previously) include the following: 

• Visit to Harvard-Smithsonian Center for Astrophysics to see the MicroObservatory 
telescopes in person. 

• Visit to lab/research center to interact with astronomers using similar image 
processing tools in their work 

• Visit to museum to observe the work of a curator in organizing an exhibit and to get 
ideas for youth’s own exhibition  

o The Museum of Science, Boston, astronomy gallery outside the planetarium 
is free 

o Other local museums may not have astronomy displays, but can still be 
relevant to the program—In Boston, Museum of Fine Arts, MIT Museum 

• Visit to a workshop/observatory for making telescopes / observing 
• Visit to a planetarium (could include exhibits?) 
• Visit to lab/research center where you work. 
• Visit to any company / lab where image processing is used on a regular basis 

(medical imaging, x-ray technician, etc.) 
 
Youth are encouraged to choose at least one question and associated image they have 
processed to ask any experts they may encounter during the field trip. 
 
 
Arrange for youth to meet you at the field trip location at a certain time. Be sure to leave 
“wiggle room” for traffic or transportation delays. 
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Week 6 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Process the remaining images in their portfolios 
2. Write the remaining captions for their images 
3. Choose images for their exhibit displays 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. A strategy for providing feedback to their peers 
2. How to make choices using their own and other people’s opinions 
3. That all their processing challenges play a role in the final exhibit! 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Review Field Trip and write Thank You cards 
2. Review Agenda and Vocabulary 
3. Challenge: Final Processing & Caption Writing 
4. BREAK 
5. Activity: “Best in Show” peer feedback 
6. Activity:  Develop exhibit image groups for 

Astrophotography exhibit 
7. Closing Circle 

5 Minutes 
5 Minutes 
25 Minutes 
5 Minutes 
20 Minutes 
15 Minutes 
15 Minutes 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Retrieve youth’s requested images from Week 4 and load them onto the computers 
If desired, fill out “Image Template” worksheet with existing images and accompanying captions  
Print out document and place pages in respective youth’s portfolio folders  
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the youth 
to see. 
 

No new vocabulary, but words from past weeks should be posted 
Focus Vocabulary: zoom, contrast, brightness, noise 
Additional Vocabulary: crop, pixel, false color table  
 

Materials and Equipment 
 

Physical resources: Youth folders (with all existing images, captions, and observing logs), blank 
processing logs, Post-Its, colored stickers for voting, writing utensils, Astrophotography exhibit 
Voting template slips (if desired) 
 

Electronic resources: Full supply of images requested by youth, loaded onto computers 
 

Computing resources: Image processing software 
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Week 6 Activity: Final processing and caption writing Time: 25 minutes 

 

Procedure 

 
• Youth take time to finish processing final 1 to 2 

images. 
 
• Youth create captions for any images they want to 

be considered for the final exhibit display.  
 
• Youth can add to captions, based on the answers to 

questions they had about each image that may 
have been answered during the field trip. 

 
• If time, youth can use resources to find answers to 

questions they have raised about their images.  
 

Objective 
 
To finish all captions for 
processed images 
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Week 6 Activity: “Best in Show” peer feedback Time: 20 minutes 

 

Procedure 

 
PREPARATION (5 minutes) 
 
• Print out or have each youth display all images for 

consideration on their computer screen. 
 
• Print/write out captions for each image and display it 

near the image.  
 
VOTING (10 minutes) 
 
• Youth take a few minutes to wander around the room 

and mentally identify their favorite image/caption 
combination created by their peers. 

 
• Each youth/facilitator gets 10 or so sticky dots 
 
• Youth/facilitator place sticky dots on the labels 

associated with their favorite images 
 
CHOOSING (10 minutes) 
 
• Youth return to their image collection and choose 

their top 2-3 images for the astrophotography exhibit 
(Sticky dots provide feedback about which images 
their peers liked best, but the ultimate decision is their 
own.) 

 
• Youth assemble their chosen images and 

accompanying captions 
 
 

Objective 
 
To provide positive feedback on 
youth’s images 
 
To choose final images for 
exhibit displays 
 

 
Materials needed: Sticky dots, pens/pencils, Post-Its 
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Week 6 Activity: Develop image exhibit groups Time: 15 minutes 

 

Procedure 

 
• Youth present each of their chosen images to the 

group, pointing out important vocabulary that their 
selections include 

 
• With input from youth, facilitator presents possible 

groupings for final exhibit displays, based on the 
submitted images and range of vocabulary 

 
• Some ideas for groupings include the following:   

o type of object (solar system, nebulae, galaxies)  
o color 
o image processing tool used 

 
• If needed, youth can vote on the final groupings.  
 
• Note:  assigning youth to a particular group happens 

in week 7, but if there is extra time, facilitators can 
get a head start on this by soliciting 
requests/preferences in week 6  

 

Objective 
 
To decide the group themes for the 
exhibits.  
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Week 7 (Creative Element Construction) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Complete at least one “creative element” for their exhibit displays, including a caption 
2. Create an overall written introduction for their exhibit display 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. Organizational skills for sharing work between team members 
2. Time management skills for working within a deadline 
 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Review Agenda 
2. Choose exhibit groups 
3. Lighthouse Game (Teambuilding Activity) 
4. “Creative element” construction 
5. Clean up 
6. Closing: Lighthouse Awards 

5 Minutes 
10 Minutes 
10 Minutes 
50 Minutes (including break) 
5 Minutes 
10 Minutes 

Preparation and Space Set up: 
Post daily agenda, 10-week program outline, and focus vocabulary for youth 
Insert processed images and captions chosen for display into the “Images Template” (if desired)  
Print out remaining processed images and captions and place them in the appropriate portfolios 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the youth 
to see. 
 
No new vocabulary, but words from past weeks should be posted (they will be helpful in writing 
captions and/or preparing for next week’s vocabulary competition).  
Focus Vocabulary: Moon, planet, star, nebula, galaxy,  
Additional Vocabulary: Our Solar System, Milky Way, universe 
 

Materials and Equipment 
 
Physical resources: Blindfolds, candy, exhibit display boards. craft supplies, youth’s printed-out 
images and captions for exhibit displays, Astrophotography exhibit Planning checklists, 
(optional) sample exhibit display created by facilitator to show youth, Astrophotography exhibit 
Voting slips if not already decided 
 
Electronic resources: None, but youth’s images should still be on the computers 
 
Computing resources: None, unless text for exhibit display boards is to be typed/printed during 
the session or additional images need to be processed (software would be needed for this) 
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Week 7 Activity: Choose exhibit groups Time: 10 minutes 

 

Procedure 

 
• facilitator sets out all color images and associated 

captions for each of the exhibits, as determined in 
week 6. In each area, one piece of paper is available 

 
• Youth vote on which exhibit “team” they’d like to 

work.  
 
• While facilitators create the final exhibit groups, 

youth visit every exhibit area and brainstorm ideas 
for possible “creative” projects that could go with 
each exhibit area. 

 
o Examples include words for astropoems, 

sketches for sculptures, or some other idea 
(flipbook, game, etc.) 

 
o Youth write ideas on a common piece  

of paper to be left in that area.  
 
• facilitator announces final groups (which then stay 

together for the light house opening challenge).  
 

Objective 
 
To choose the youth who will 
work on each exhibit display 
 
To allow all youth to have 
creative input on each exhibit 
section 
 

 

Materials: All color images and captions, scrap paper 
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Week 7 Activity: Lighthouse Game (Teambuilding) 
 

Time: 10 minutes 
 

Procedure 
 
MODEL THE ACTIVITY 
 

• Set up a short obstacle course of furniture, etc. and 
positions one facilitator at one end of it, with a few 
pieces of candy in his or her hand.  

• Blindfold the facilitator with the candy.  
 

• The blindfolded facilitator is the “ship,” the candy is the 
“cargo” and the other facilitator is the “lighthouse,” who 
must guide the ship through the course to deliver the 
cargo by giving very specific and clear instructions 
(turn a little bit to your left, take a small step forward, 
etc.) 

 

• When the ship makes it through the course without 
hitting any of the furniture, the lighthouse gets the 
cargo as a reward for good guidance.   

 
DO THE ACTIVITY 
 

• Youth take turn being ships and lighthouses within 
their project groups. (For groups of three or more, take 
turns giving instructions, or have two lighthouses 
guide the ship through different parts of the obstacle 
course.) 

 

• If the ship is guided through the course and manages 
to deliver its cargo without running into anything, the 
lighthouse gets to keep the cargo as a reward for good 
guidance. 

 
DISCUSS THE ACTIVITY 
 

• Astronomers work in teams and must trust each other 
 

• Each component of the exhibit will require multiple 
people’s input to be successful and people will have to 
work on each other’s ideas.  

Objective 
 
To develop trust among peer 
groups 
 
To practice giving clear, specific 
instructions and explanations 

Materials: Blindfolds, small pieces of candy 
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Week 7 Activity: Creative element construction Time: 50 minutes 
(including break) 
 

Procedure 
 

• Based on brainstormed ideas contributed for each 
exhibit display group, youth decide on one or more 
possible “creative elements” that is inspired by one or 
more of the images/captions in their display.  

 

o Youth should focus on astropoems and/or 
astrosculptures, but can decide on other creative 
expressions like flip-books, games, songs, etc. 

 

• Youth select one or more ideas, and assign team 
members to construct /create them.  

 

• For each “creative element” constructed, youth must 
write a caption answering the following question:  How 
is this creative element related to the image(s) in 
your display?    

 

• For each group’s exhibit, youth must write a “written 
introduction” about the overall exhibit, answering the 
following question:  What is this exhibit about? 

 

Objective 
 
To complete a creative element to 
the exhibit, including a caption.  
 
To create a “written introduction” 
for each segment of the exhibit 
(one per youth group)  
 
 
 
 
Note: By the end of Week 7,  
all components of the exhibit 
displays should be completed! 
 
 
 
 
Youth should be sure to point out 
important vocabulary in their 
captions 
 

 

Materials: Construction materials, construction paper for astropoems, “creative element” 
captions and “written introduction” 
 

Week 7 Activity: Lighthouse Awards (Teambuilding) Time: 10 minutes 

 

Procedure 
 

This is a closing circle activity 
 

• Youth give “shout outs” to someone else on their 
team, praising something that person did to 
guide/help them with their project 

 

• Both youth (the “shouter” and the person he/she 
recognizes) get a prize 

 

Objective 
 
To recognize team members for 
their contributions to the group 
project 
 

 

Materials: Prizes (candy or paper/sticker stars) 
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Week 8 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Complete building their exhibits 
2. Identify important things to share about their exhibits, based on peer feedback.  
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. Organizational and time management skills for group work 
2. What other people like/want to learn more about in their displays 

 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Review Agenda 
2. Vocabulary Review Challenge 
3. Construct exhibit  
4. BREAK (with clean up) 
5. Exhibit Gallery Interviews 
6. Closing: Share interesting points about exhibit 

5 Minutes 
15 Minutes 
20 Minutes 
10 Minutes 
30 Minutes 
10 Minutes 
 

Preparation and Space Set up: 
Post daily agenda and 10-week program overview  
Lay out exhibit displays and unattached materials for each group 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
No new vocabulary 

Materials and Equipment 
 
Physical resources:  All printed images and captions for the display, poems/models created 
the week before, glue, etc. for final construction of exhibit display 
 
Electronic resources: Slide show of example “creative presentations” from past programs (or 
printed photos thereof if a projector/computer is not available) 
 
Computing resources: None 
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Week 8 Activity: Vocabulary Competition Time: 15 minutes 

 

Procedure 

 
PREPARATION 
 
• Write each vocabulary word on an index card, shuffle 

all cards, and put them in a box/hat/bag 
 

o Telescopes: telescope, aperture, mirror, shutter, 
detector, image 

 
o Image processing: sharpen, zoom, brightness, 

contrast, false color table, noise 
 

o Astronomy: Moon, planet, star, nebula, galaxy, 
universe, Solar System, Milky Way 

 
• Category distinctions can be given as hints, if desired  
 
DO THE ACTIVITY 
 
• Split the youth into small groups, preferably those in 

which they will be working on their exhibit displays 
 
• Individuals take turns drawing a word from the 

box/bag/hat and, after consultation with their team, 
trying to define it 

 
• If they get it right (as judged by the CT), they get a 

point 
 
• If they get it wrong the other teams get a chance to 

“steal” the point by supplying the correct definition 
 
• Team with the most points gets a prize 
 
• Vocabulary remains posted for the rest of the session 

(teams may not get through all the words—the 
facilitator may choose to end the game before all words 
are defined) 

Objective 
 
To review vocabulary from the 
program 
 
To encourage cooperation and 
conversation within teams 
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Week 8 Activity: Construct exhibit Time: 20 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (facilitator) 
 
• facilitator arranges several pre-chosen images, 

captions and self-made creative element into a well-
organized “example exhibit.”   

 
• Model positive handling of conflicts about “what goes 

where”, as well as good gluing techniques (i.e. not too 
much!), and prominent placement of title. 

 
• Additionally or alternatively, show physical examples or 

pictures of previous KCU astrophotography exhibits to 
spark youth creativity.  

  
 
DO THE ACTIVITY 
 
• Youth construct their exhibit, following guidelines 

demonstrated by facilitator. 
 
• Once all components are attached, youth may decorate 

the displays 
 

Objective 
 
To construct exhibit with good 
teamwork and cooperation.  
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Week 8 Activity: Exhibit Gallery Interviews Time: 30 minutes 

Procedure 

 
All exhibit displays should be fully assembled and 
displayed around the room before beginning this activity. 
 
MODEL THE ACTIVITY (5 minutes) 
 
• Using the example exhibit they’ve constructed, the 

facilitators take on the roles of an exhibit designer and 
exhibit visitor. 

 
• Exhibit visitor asks questions, including some of the 

following: 
o How did you get these images? Where did they 

come from? 
o Which is your favorite image, and why? 
o How are these images the same and/or different? 
o Why did your group choose to make this particular 

creative element? 
o What is different/similar about the objects in these 

two images?   
o Tell me about how this image was created 
o What’s the difference between this nebula here, and 

that galaxy, there?   
o What tools did you use to make these two images of 

the same object look different? 
o Show me an interesting detail about that image.  

 
• Exhibit designers use vocabulary correctly to answer 

questions, and also interviews the visitor, recording 
answers to the following questions: 
o What do you find most interesting about our 

display? 
o What do you want to know more about? 

 
For a more interactive/lively exchange:  Youth are 
rewarded for using vocabulary correctly in both questions 
and answers. Each time a team uses a vocabulary word 
correctly, they get a point awarded by facilitator. Team with 
most points at end gets a reward.  
 

Objective 
 
To experience what it is like for 
visitors to visit the exhibition. 
 
To provide constructive 
feedback on the information 
presented in the exhibit displays 
 
To come up with a creative way 
of teaching about the astronomy 
content in the exhibition 

 



Kids Capture Their Universe: An Astronomy Out-of-School Program 
 

The “Kids Capture Their Universe” (KCU) astronomy program was developed  
by MIT Kavli Institute (MKI) and the Smithsonian Astrophysical Observatory (SAO),  
in partnership with Citizen Schools, Boston.  

 

63 

 
DO THE ACTIVITY (20 minutes) 
 
• Pair display groups, along with a facilitator with each 

pair. 
 
• Begin at one group’s display, spending 1-2 minutes 

silently examining/reading the information presented. 
 
• Exhibit visitors ask questions, with some help from 

facilitator, if needed.  
 
• The designer group should interview the visiting group, 

recording answers to questions on the right 
 
• Repeat the above exchange at the other group’s 

display, reversing roles. 
 
APPLY THE ACTIVITY (5 minutes) 
 
• Based on recorded answers and questions, exhibit 

design groups record 1 to 2 things they would like to 
emphasize in their oral presentation. These should be 
reflective of what the other group found most 
interesting. These ideas can be shared during closing 
circle. 

 

 
 
 
 
 
 
 
 

 

Materials Needed: Paper and writing utensils for taking notes 
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Week 9 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Practice giving oral presentations  
2. Provide feedback to classmates on oral presentations 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. How to give and receive positive and constructive feedback to and from peers 
2. How to effectively engage audiences with astronomy content 
 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Review Agenda 
2. Activity:  What makes a good presentation? 
3. Practice presentations & provide written feedback, 

including break 
4. Closing circle 

5 Minutes 
30 Minutes 
45 Minutes 
 
10 minutes 

Preparation and Space Set up: 
Post daily agenda and 10-week program overview 
Make copies of Presentation Feedback form 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
No new vocabulary 
 

Materials and Equipment 
 
Physical resources: Completed exhibit displays, Presentation Planning worksheets, Peer 
Review feedback forms, writing utensils 
 
Electronic resources: 
 
Computing resources: 
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Week 9 Activity: What makes a good presentation? Time: 30 minutes 

 

Procedure 

 
MODEL THE ACTIVITY (15 minutes) 
 
• Model a “bad” presentation 

 

o Hard to understand (orally) 

o Hard to understand (content-wise, incorrect use of 
vocabulary) 

o Bored/uninterested presenter 

o Not paying attention to the audience 

o One person dominates and the other does not contribute 

o Is not clear when the presentation has ended 

 
• Ask youth what the presenter(s) could have done to improve 

the presentation 
 
• Write the qualities of a good presentation on the board and 

hand out the “KCU exhibit Criteria for Excellence” review 
forms, which include the following:  teamwork, good 
explanations (i.e. use of vocab), presentation style. 

 
• Facilitator lists possible roles for youth to take, and brainstorm 

more with youth’s help (see list below) 
 
DO THE ACTIVITY (15 minutes) 
 
• Youth plan their own presentations, based on what they want 

to share about their exhibit, and the criteria and roles 
presented.  

 
• Youth can be asked to explicitly select roles, if that works well 

for your group. (Choose several roles from the list below and 
create a “sign-up” sheet for each group.) 

 

Objective 
 
To identify the 
elements of a good 
presentation 
 
To practice 
presenting 
 

 
Suggestions for presentation roles are listed on the next page.
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Suggestion for Youth Roles in the Presentation 
 

• Welcome people to the exhibit 

• Present the overall theme of this panel of the exhibit. 

• Point out an image and present the caption to explain WHAT the object is (using 
vocabulary correctly). 

• Point out an image and present the caption to explain HOW the image was processed 
(using vocabulary correctly.) 

• Point out an image and then SHOW how that image was processed by taking a visitor 
through that process on a nearby computer until the image is exactly like what's on the 
exhibit. (THIS IS A HUGE WOW FACTOR FOR AUDIENCES!!) 

• Help visitors to take their own image on the Guest Observer Portal (Note: computer 
with internet connection needed in the Astrophotography exhibit space) 

• Define an important vocabulary word (for example, if all exhibit pictures are galaxies, 
explain what a galaxy is) 

• Define an important processing tool and explain what it does, using example images, if 
possible 

• Show a processing tool on a nearby computer. 

• Present the "creative element” (read poem or point out features of sculpture/model) 
and explain which images inspired its creation. 

• Explain why two images of the SAME object look different. 

• Tell about what happened during the program over the past 10 weeks using parts of 
your exhibit as visual aids 

• Describe the field trip and do a teachback about what you learned there. 

• Tell about your most and least favorite part of the program and WHY. 

• Create a kinesthetic model as a group, with one or more narrators (e.g. telescope or 
lifecycle of a star) 

• Explain what a telescope does, if there are exhibit images to support that explanation. 

• Explain how astronomers use color when displaying images. 

• Point out features of an image while a teammate talks about it. 

• Explain why they organized the display the way they did. 

• Thank visitors for coming to your exhibit. 

• Anything else that your group wants to share about the exhibit or the program! 
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Week 9 Activity: Practice presentations with written 
feedback 

Time: 40 minutes 

 

Procedure 

 

• Youth present to at least one other group, if not the whole 
class. 

 
• Class gives oral and/or written feedback on the presentation, 

based on the criteria for excellence: 
 

TEAMWORK 

o Good transitions between youth  

o Each youth has a role in the presentation 

o Youth give credit to the work done by others 

GOOD EXPLANATIONS 

o Includes astronomy vocabulary, used correctly 

o Includes image processing vocabulary, used correctly 

o Youth use descriptive words in place of “it”, “this”, “thing”, 
etc  

PRESENTATION STYLE 

o Youth point to features of visual aid (image, model, etc.) 
when talking about them 

o Youth make eye contact 

o Youth speak slowly, loudly and clearly Not paying attention 
to the audience 

• If time, youth present again, incorporating that feedback.  

Objective 
 
To practice 
presenting  
 

 

Materials needed: writing utensils and peer review feedback forms (Page 86) 
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Week 10 (Final Preparation for the astrophotography exhibit) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Practice presenting twice 
2. Choose a peer representative to represent their program at the astrophotography 

exhibit.  
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. How to give effective presentations in front of an audience 
 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Opening: Survey 
2. Make final changes to exhibit displays, if necessary 
3. BREAK (can occur between rounds of Astronomy Idol) 
4. Icebreaker: Color-Passing Challenge 
5. Challenge: Astronomy Idol 
6. Closing: Prepare for astrophotography exhibit 

5 Minutes 
15 Minutes 
5 Minutes 
10 Minutes 
45 Minutes 
10 Minutes 

Preparation and Space Set up: 
Post daily agenda and 10-week program overview 
Make additional copies of Presentation Feedback forms if necessary 
Choose space for Astronomy Idol (auditorium, cafeteria, etc.), set up working spaces for 
each exhibit display group, if necessary 
 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
N/A 

Materials and Equipment 
 
Physical resources: Exhibit displays, glue, markers, and (minimal) craft supplies, prize for 
Astronomy Idol, presentation feedback forms 
 
Electronic resources: Images for processing demonstrations, if necessary 
 
Computing resources: Image processing software, if necessary 
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Week 10 Activity: Color Passing (Skill building) Time: 10 minutes 

 

Procedure 

 
DEMONSTRATE THE PURPOSE OF THE ACTIVITY 
 
• Start by shouting the explanation loudly and 

incoherently; then, slow down and repeat what you 
said so youth can understand you 

 
• Explain If you do not speak clearly, no one will 

understand what you are saying 
 
• In large rooms, voices tend to echo, which makes it 

hard to understand what someone is saying 
 
• Speak slowly and loudly, but do not shout 
 
• Take breaks between thoughts of a sentence so the 

audience can have time to absorb and process the 
information you are giving 

 
MODEL AND DO THE ACTIVITY 
 
• Everyone stands around the edged of a large (echo-

y) space, as far away as other people as possible 
 
• One facilitator models the activity by “passing” to 

another facilitator: 
“My name is TEACHER and I pass BLUE to 
LEADER” 

 
• The second facilitator models the activity by 

“catching” the color, and saying “BLUE!” 
 
• The second facilitator passes a new color to 

someone else in the room 
 
• Continue passing and catching colors (or other silly 

words) around the room 
 

Objective 
 
To practice speaking slowly, 
loudly, and clearly 
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Week 10 Activity: Astronomy Idol Time: 45 minutes 

 

Procedure 

 
Facilitator acts as emcee for the competition 
 
ROUND 1 (15 minutes) 
 
• Each group presents their exhibit/demonstration to 

their peers. 
 
• Other groups evaluate the presentations, using the 

feedback form provided by the facilitator 
 
• After each group has presented, the other groups 

provide oral feedback (one positive response, one 
suggestion for improvement) based on their written 
forms 

 
ROUND 2 (15 minutes) 
 
• Each group presents again, taking into account the 

feedback they have received 
 
• After all groups have presented, all individuals vote 

anonymously on which presentation was most 
effective and engaging. 

 
• Facilitator tallies the votes (including their own) and 

gives a prize to the most deserving Astronomy Idol. 
 

Objective 
 
To practice presenting 
astronomy content to an 
audience 
 
To provide feedback on youth’s 
presentations 
 

 
Materials: Pens/pencils, feedback forms, clipboards/notebooks to write on, prize for 
winner of the competition 
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Week 11 (Optional Reflection) 

Lesson Objectives: What do we need to get done today? 
By the end of the lesson, the youth will: 

1. Reflect on the program and the Astrophotography exhibit events 
 

Learning Objectives: What will the youth learn today? 
By the end of the lesson, the youth will have learned: 

1. N/A 
 

Agenda based on the lesson plan. Post in the room for the youth to see. 
1. Post-program survey 
2. KCU Focus Group 
3. Some game of youth’s choice 

10 Minutes 
15 Minutes 
Remaining Minutes 
 
 

Preparation and Space Set up: 
Set up feedback questions as stations around the room 
Set up circle of chairs for group discussion/focus group 

Vocabulary What terms or concepts will you introduce in this session? Post these for the 
youth to see. 
 
N/A 
 

Materials and Equipment 
 
Physical resources: Method for recording youth’s reflections 
 
Electronic resources: N/A 
 
Computing resources: N/A 
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Activity: KCU Focus Group Time: 15 minutes 

 

Procedure 

 
• After giving youth the post-program survey, have them sit 

in a circle to reflect on and discuss their experience 
during the program.  

• It may be advantageous to have youth think quietly or jot 
down ideas about a question before discussing it with the 
whole group, to give them time to develop meaningful 
contributions. Alternatively, they could even discuss 
different questions in subdivided groups.  

• The goal here is to give youth a chance to see how far 
they’ve come in 10 weeks, as well as give the facilitator 
some feedback, if they’d like to run the program again. 
(And we hope you do!) 

 
Possible questions / reflections to bring up: 

• Have youth remind each other what happened during 
each week of the program, using the 10 week outline 
plan as a visual guide.  

• What was your most favorite thing about the program? 
• What was your least favorite thing about the program? 
• What was the funniest thing that happened? 
• What was the most important thing you got out of 

being a participant this semester?   
• If you were teaching the program, what would you do 

differently? 
• What would you tell other kids about this program, if 

you were advertising it?   
• What do you feel most proud of about your 

astrophotography exhibits?   
• What was the best part about participating in the 

Astrophotography exhibit? 
• How do you think you are different now than on day 

one of the program?   
• Is this what you thought “doing science” would be like? 
• How was the program different from what you 

expected? 
 

Objective 
 
To reflect on their 
experience and give 
feedback to the facilitator  
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Supplemental Activities  
 

Supplemental Activity: Making Images With Mirrors 
 
 

Time: 10 minutes 

Procedure 

 
PREPARE THE ACTIVITY 
 
• Set up a bright light bulb or other source at one side of 

a room or hallway (this activity can be done outside if a 
plug is available). If no light bulb is available, this 
activity will sometimes work with a day-lit window in a 
darkened room 

 
• Test the activity before doing it with youth—if the 

conditions are not right, the activity will not serve any 
purpose except to frustrate the youth! 

 
• Use the template on page E-2 in the curriculum to cut 

out the aperture on the aperture/detector worksheet. 
Use a piece of scrap paper or cardboard as the shutter 

 
• Make enough of each page (aperture/detector & 

shutter) for each pair of youth. 
 
DO THE ACTIVITY 
 
• Give each pair of youth a concave mirror, such as 

cosmetic mirrors found in a traditional drug store, a 
shutter page, and an aperture/detector page. 

 
• Their challenge is to focus the light from the light 

source to create an image of the light source on the 
detector. 

 
DISCUSS THE ACTIVITY 
 
• Can they explain how they made their image? What 

does the shutter do? What is the path of the light? 
 

Objective 
 
To learn how light travels 
through a telescope and how 
astronomical images are made 

 
Materials Needed: Pre-made aperture/detector pages, pre-labeled shutter pages, 
concave mirrors, bright light bulb or other detectable light source 
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Supplemental Activity/Discussion:  Images from telescopes Time: 10 minutes      

 

 
This activity is more of a discussion than a processing 
challenge, but it is done around a computer. 
 
• Open MicroObservatoryImage from shortcut on 

desktop. 
 
OBSERVATION (5 minutes) 
 
• Open the image of the Prudential tower captured 

WITHOUT a telescope 
• Explain that this is a digital image taken with an 

ordinary digital camera from the roof of the Harvard 
Observatory, where MicroObservatory telescopes 
are located. 

• Ask youth how they would describe the tower just 
from looking at the non-telescope image 

• Record (or have youth record) their observations 
• Open the image of the Prudential tower captured 

WITH a telescope, explaining that it was taken from 
the same location, but with a telescope 

• Ask youth how they would describe the tower just 
from looking at the telescope images 

• Record (or have youth record) their observations. 
• Optional: Youth can create a caption to describe the 

two views/images. 
 
DISCUSSION (5 minutes) 
 
• Why use telescopes? What do telescopes do? 

o Make a far-away object appear closer 
o Show more detail in/on an object  
o Collect more light (objects appear brighter, but 

this is not shown by observing the images of the 
Prudential Center) 

 
• Optional: Zoom in on the tower in the non-telescope 

image so that it shows the same field of view as the 
telescope image…do they look the same now? 

 

Objective 
 
Model how to open images using 
MicroObservatoryImage 
 
Learn what a telescope does: 
• Makes far-away objects appear 

closer 
• Shows more detail about objects 
• Collects (more) light (than can be 

collected without a telescope) 
 
(Optional) Model the use of the Zoom 
tool. 
 
 
 

Supplemental Processing Challenge: Color Tables Time: 10 minutes 
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Each computer station should be assigned a different 
color table, either by random assignment or by having 
youth drawing the color table names out of a hat. 
 

1. Write the name of the color table at the top of the 
page and create a 3x3 chart below it, labeling the 
rows and columns as in the examples to the left. 

 

2. Open an already-processed image such as Tower2 
 
3. The facilitator first models the activity using the Gray 

Scale color table 
 

4. Apply the assigned/chosen color table to an already-
processed image by choosing “Process” > “Color 
Table” > “Gray Scale” (or “Red” or “Spectrum,” etc.) 

 

5. Fill in the second line of the chart by observing which 
colors represent the highest, lowest, and in-between 
pixel values in the image. 

 

6. Save the image as a GIF with a descriptive name 
 

7. Re-open the image and apply the assigned color 
table, then choose “Process” > “Invert Color” 

 

8. Fill in the third line of the chart for the new 
appearance 

 

9. Save the new image as a GIF with a different name 
 
 
REFLECTION 
 

1. Open both images so they are visible on the screen 
 

2. Walk around the room and look at all the images that 
have been created. After observing them all, each 
youth stands next to his or her favorite view 

 

3. Each person/group must come up with a reason why 
they chose that image as their favorite and share it 
with the group (beyond “I like the color”) 

 

Objective 
 
Apply color tables to change the 
appearance of an image 
 
Articulate your personal connection 
to an image 
 
Color Table: Gray Scale 

 High 
Pixel 
Values 

Pixel 
Values In 
Between 

Low 
Pixel 
Values 

False 
Color 

White Light gray 
Dark gray 

Black 

Inverted Black Dark gray 
Light gray 

White 

 
Color Table: Blue 

 High 
Pixel 
Values 

Pixel 
Values In 
Between 

Low 
Pixel 
Values 

False 
Color 

Bright 
blue 

Royal blue 
Navy blue 

Black 

Inverted Black Royal blue 
Navy blue 

Bright 
blue 

 
Example Color Table: Fire 

 High 
Pixel 
Values 

Pixel 
Values In 
Between 

Low 
Pixel 
Values 

False 
Color 

White Yellow 
Orange 
Red 
Purple 
Blue 

Black 

Inverted Black Blue  
Turquoise 
Green 
Yellow 

White 

 

Other color tables:  
Red, Green, Spectrum, Ice 
 
Prompts: What is it about this color 
choice that you like? What features of 
the image stand out? Does it remind 
you of anything? 



Kids Capture Their Universe: An Astronomy Out-of-School Program 
 

The “Kids Capture Their Universe” (KCU) astronomy program was developed  
by MIT Kavli Institute (MKI) and the Smithsonian Astrophysical Observatory (SAO),  
in partnership with Citizen Schools, Boston.  

 

78 

 

This page left blank intentionally for 
double-sided printing 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



Kids Capture Their Universe: An Astronomy Out-of-School Program 
 

The “Kids Capture Their Universe” (KCU) astronomy program was developed  
by MIT Kavli Institute (MKI) and the Smithsonian Astrophysical Observatory (SAO),  
in partnership with Citizen Schools, Boston.  

 

79 

Worksheets and Templates 

Useful Tools for Running the Program 

 
Pre/Post Program Survey 

Assessment tool for Weeks 1 and Week 10 or 11 

 
Observing Logs 

For keeping track of telescope requests—can be recorded by 
individual youth, or a collectively across the whole group 

 
Image Processing Log 

For youth to keep track of the images they save and create 
good captions to accompany the saved images 

 
Checklist for Astrophotography exhibit 

Youth-friendly requirements for the exhibit displays 

 
Oral Presentation Planning 

For figuring out which topics and images will be included in 
each group’s oral presentation, and who will present each part 

 
Presentation Feedback Form 

Peer review criteria for practicing and improving presentations 

 
Image Display Template 

Model of how facilitator can consolidate final images and 
captions for the exhibit displays (color printer recommended) 

 
Group Preference Forms 

A strategy for taking youth preference into account when 
choosing who will work on which exhibit displays 
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Kids Capture Their Universe  Program Survey 
 

Name: __________________________________ Date: ___________________ 
 
1.  What is your favorite… 
School subject: _____________________   Music: ________________________ 
 
Hobby: ___________________________    Sport:_________________________    
 
Food:____________________________ 
 
 
2.  Imagine this:  You are about to stand up in front of 20 classmates and talk for a 
couple of minutes about a project you completed.      
 
On a scale of 1 (=really uncomfortable) to 5 (= really comfortable), rate how you 
would feel at that moment:  _______ 
 
 
3. On a scale of 1 (= “I really DON”T think this”) to 5 (=”I really DO think this”), rate 
how you feel about each of these statements:  
 
I am happy that I am in the KCU program.  ______ 
 
It is possible for everyone to be important in a group science project.  ______  
 
Accepting feedback from my classmates is important to me.  ______  
   
 
 
4. What are words you’d use to describe or tell 
about this object? 
 

 

 

 

 
 
CONTINUED ON NEXT PAGE!!!
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5. Circle the single best answer for this question: 
 
Our solar system contains: 

a. One average star 

b. Several stars spread across space 

c. One older, dimmer star, and one younger, brighter star 

d. Three stars 

e. No stars 

 
6. Circle all the words that YOU think of when you think about doing science. 
 
working alone   hard   important to me   easy  

creative   understandable  group work  interesting  

boring    fun   scary 

 
 
6. Write down questions you have about astronomy, outer space and the universe:    
 
 
 
 
 
 
 
7. Describe what is different about these two images: 
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Observing Log Name:         
 
Go to http://www.MicroObservatory.org to take images with the MicroObservatory 
online telescopes. Record your observations below. Keep this log in your folder. 
 

Date of 
Observation 

Object Name  
(e.g. Moon, M101 Galaxy) 

Other Notes ! 

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    

    
 

!  Make a check mark next to an object when you have processed its image! 
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Group Observing Log  (Alternative to Individual Logs) 
 

Create a master version of this chart and display it publicly to fill out each week. 
 

Object Type 
Object Name  
(e.g. Moon, 
M101) 

Taken By  
(Youth Names) 

Date 
Requested 

Mark when 
processed 

    

    

    

In Our 

Solar 

System 

     

    

    

    

Stars and 

Clusters 

of Stars 

     

    

    

    

Nebulas 

 

 

     

    

    

    

    

Galaxies 
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Image Processing Log  
 
Fill this out whenever you process an image. If you have any questions about what is 
going on in your image, be sure to ask a facilitator! 
 
My Name:             
 
Object Name and Type:           
 
Name of Saved Image:           
 
Date Processed:            
 
 
1. How were image processing tools used to make the image appear like this? 
 
 
 
 
 
2. What do you want other people to know or notice about this object? 
 
 
 
 
 

3. What words do you think of when you look at this image?  Does the image remind 

you of anything else? 
 
 
 
 
 
 
4. What question(s) do you have about this object or image?  
 
 
 
 
 
 
 
Use your answers to create the final caption for this image. Don’t forget the 
title! 
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Astrophotography Exhibit Checklist 

Your astrophotography exhibit is made up of several displays. 
Each display in your exhibit must have the following parts: 
 

! Display Name/Title:          
 

! Names of People Working on this Display 
 

Write them here: 
 

! Processed MicroObservatory images 
 

! Captions for the MicroObservatory images 
 

! Creative element for the display 
 

      __ Sculpture  __ Poem  __ Other 
 

! Caption for the creative element 
 

How does this element relate to the image(s) in your 
display? 
 

(Write your caption on a separate page) 
 

! Written introduction to the WHOLE Display 
 

What is this display about? 
 
(Write your explanation on a separate page) 
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Kids Capture the Universe: Oral Presentation Planning 

 
GROUP/EXHIBIT NAME:          
 
You will be presenting your astrophotography exhibit. Don’t forget to: 
 

• Welcome your visitors and introduce yourselves. 
 
• Tell the story of your display—the theme, organization, and 

inspiration. Don’t forget to include the important astronomy 
information! 

 
• Tell the story of your creative element—what you made and why 

you made it. (You can use the information in your caption to help 
you.) 

 
• Highlight some of the images in the display (not just your own!) and 

teach back about them in some creative way. 
 
• Thank your visitors for coming and invite them to explore the 

display.  
 
Who will do what for your oral presentation? 
 

Role or Responsibility Who Will Do This? 
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Astrophotography Exhibit Peer Review    

 
Exhibit Name:            
  
Presenters’ Names:           
 
Check the box you think indicates how well this group did with each guideline: 
 

 
Criteria for Excellence 

Did 
great! 

Did 
okay 

Needs 
improvement 

Teamwork: 
• Each person has a role in the presentation 
• Presenters give credit to the work done by 

others 
• Good transitions between presenters 

   

Good Explanations: 
• Includes astronomy vocabulary, used correctly 
• Includes image processing vocabulary, used 

correctly 
• Presenters use descriptive words in place of 

“it”, “this”, “thing”, etc. 

   

Presentation style: 
• Presenters point to features of visual aid 

(image, model, etc.) when talking about them 
• Presenters make eye contact 
• Presenters speak slowly, loudly and clearly 

 
 

  

 
One thing I liked about this group’s exhibit and presentation is… 
 
 
 
 
 
 
One thing this group could improve about their exhibit and presentation is… 
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Template for Collating Images and Captions for the 
Astrophotography exhibit! 
 
Ideally, youth will write or type up their own captions. This is a template 
that youth or facilitators can use to combine the digital GIF files from the 
youth’s computers and the caption information from the processing logs 
of chosen images. Example pages follow this template. 

 
 

Delete the text and insert saved GIF image here 
 

If a youth has saved an un-zoomed image, but wants to display it in 
a zoomed format (e.g. a Moon crater), you must: 

 
Crop the image around the zoomed area. 

Enlarge the cropped image so it is roughly the same size as the 
other images in the exhibit. (Example images are both zoomed.) 

 
One image/caption pair per page is a good model. In the event that 

a youth wishes to pair two images (to show an image before and 
after processing, for example), the layout can, of course, be 

adjusted. This template is meant as a guide only! 
 

Title of image goes here (if available) 
 

Created by 
Youth(s) name(s) here 

 
 

Type caption here (from youth’s processing logs) 
 

Print the images and captions on a color printer and distribute the appropriate pages 
to each group with a glue stick. They can cut or decorate the pages as they like to 
create their exhibit display. Copy this template into a separate document to remove 
header/footer. 
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Crab Nebula 
 

By Ashley 
 

This is a dying star.  
It looks like a bird’s wing.  

To make my processed image:  
Press “Auto” and change the  

color table to Spectrum. 
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NGC 253 (Galaxy) 
 

By Duncan 
 

A galaxy is made out of billions of stars.  
This is the NGC 253 galaxy. It is bright enough  

to see from far away. It looks like a spinning top.  
Our galaxy might look exactly like this. 

 
To make my processed image, I opened it, then I 

changed the brightness and the contrast, then 
zoomed in three times and changed the color. 
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Group Preference (Request) Forms   
 

Use this template to help youth choose the groups they will be working in for 
the final exhibit displays. You can make copies of this form as-is and distribute 
the slips with a master “reference guide” to the exhibit display topics (e.g. 1 = 
Galaxies, 2 = Orion Nebula, etc. posted on a wall), or you can modify the 
document to include exhibit display names on the request slips. 

 

 

Your Name: _____________________________ 
 
Put a “1” next to the display you would be most excited to work 
on. Put a “2” next to your second choice and a “3” by your third 
choice. 
 

    ___ Display 1  ___ Display 2  ___ Display 3 

 
 

Your Name: _____________________________ 
 
Put a “1” next to the display you would be most excited to work 
on. Put a “2” next to your second choice and a “3” by your third 
choice. 
 

___ Display 1  ___ Display 2  ___ Display 3 

 
 

Your Name: _____________________________ 
 
Put a “1” next to the display you would be most excited to work 
on. Put a “2” next to your second choice and a “3” by your third 
choice. 
 

___ Display 1  ___ Display 2  ___ Display 3 
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